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Setelah Lama Ditunggu-tunggu

alah satu kesulitan pemakai Windows
9x/ME dalam ikut mempelajari hacking
dan security adalah tidak adanya scanning

tool yang benar-benar lengkap dan dapat dian-
dalkan seperti yang ada pada Linux/Unix.

Scanning tool yang diakui terbaik adalah Nmap,
yang tadinya hanya ada pada Linux/Unix serta
pada Windows NT.

Tidak heran bila kemudian nmap tersedia pula
untuk Windows 9x/ME (versi nmapfe dengan
GUI) dan untuk DOS (versi command line), hal
ini menjadi berita besar.

Tampilan nmapfe pada Windows 9x/ME berbeda
dibandingkan nmapfe pada Linux; yang jelas
adalah adanya tab menu khusu Win32 yang
diantaranya menunjukkan ethernet card apa
yang tersedia pada sistem Windows anda.

Happy scanning! Now for DOS folks as well!

Ternyata....

Tetap lebih nyaman
menggunakan nmap for
DOS daripada nmapfe
(Windows). Ini karena
fleksibilitas mengetikkan
opsi-opsinya pada
command line...

SS

Tab menu khusus Win32
pada nmapfe for Windows 1.30

yang di sini menunjukkan
interface apa saja

yang terdapat pada 
omputer anda

dalam melakukan
proses sniffing.

NmapNmap
untuk Wuntuk Windoindows 9x/ws 9x/MME (dan DE (dan DOS juga)OS juga)



Oktober 2002 NeoTek 1

HomePage

NNEOEOTETEKK
Pendamping Berselancar Salam!Salam!

ernah dengar istilah Content Management System
(CMS)? Biasanya CMS diterapkan pada situs Web
yang merupakan portal; berisi berbagai servis untuk

anggotanya termasuk halaman Web pribadi, email account,
serta kemudahan meng-upload berita.

Semua itu membutuhkan server-side scripting yang canggih
serta basisdata yang tangguh. Yang telah teruji untuk keper-
luan ini adalah PHP scripting language bersama MySQL
Database di atas Apache Web server (Linux maupun Windows).

Adapun PHP-Nuke adalah aplikasi PHP yang memanfaatkan
MySQL membentuk CMS yang canggih dan fleksibel. Lebih
hebat lagi semuanya itu gratis!

Redaksi
rreeddaakkssii@@nneeootteekk..ccoo..iidd

PPHHP-Nuke membuat urusanP-Nuke membuat urusan
porportal menjadi pekerjaantal menjadi pekerjaan

sejengkal.sejengkal.

PP

• Tampilan halaman Web pribadi anggota Neoteker Official Portal yang merupakan
perluasan dari #Neoteker di Dalnet. Hal ini dimungkinkan oleh adanya PHP-Nuke.

www.neotek.co.id

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

CHATROOM DI DALNET
#neoteker

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 506
Jl. Palmerah Utara III No. 9
Jakarta 11480

MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek
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Lengkapi pengetahuan hacking
dan PC security anda dengan
berlangganan majalah NeoTek:

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Tel.   (021) 548 1457
Faks. (021) 532 9041

email: pemasaran@neotek.co.id
Kontak: Elvi R. Nainggolan
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Nmap for Windows
Scanning tool terbaik kini terse-
dia juga untuk Windiws 9x/ME

0

Kinerja Jaringan GSM
Gunakan Logo Manager untuk
berbagai aktivitas menarik de-

ngan telepon genggam anda: membuat
gambar untuk layar, mengedit ring tone,
memeriksa kinerja jaringan GSM.

36

Web Server Sederhana
Cara membuatnya dengan Java.35

Proyek Digital Clock
Menggunakan programmer
untuk proyek digital clcok

sederhana dengan MicroController Unit
(MCU).

40

Connection Tweaking
Ketimbang keluar uang untuk
meng-upgrade komputer, atur

registri Windows dan properti modem
agar kerja modem menjadi optimal. 

43

Remote Password
Cracking
Cara masuk ke suatu sistem

secara remote dan online.

46

Situs NeoTek www.neotek.co.id
neotek.kpone.com.sg

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Perlengkapan berinternet dari situs NeoTek

Channel #neoteker di Dalnet
Ngobrol ramai-ramai sesama NeoTeker

Chat Room
Kini tidak usah jauh-jauh untuk ngobrol
langsung dengan sesama NeoTeker

Mailing List
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!

NeoTeker Official Portal
http://neotek.portal.dk3.com
Situs komunikasi antar Neoteker.

NeoTNeoTeknoekno
Mail Server Tiruan
Pelajari cara kerja server SMTP
dan POP3 dengan membuat

mail server tiruan dengan Java.

30

NeoStartNeoStart
Portal Neoteker
Sarana komunikasi lain bagi
Neoteker setelah #Neoteker.

7



Siap-siap dengan
PHPTriad
Untuk menginstal PHPNuke

atau PostNuke, anda dapat menggu-
nakan PHPTriad yang otomatas meng-
instal Apache web server, PHP dan
MySQL.

8

FileRecovery 
sang Penyelamat
Mengembalikan file yang

terhapus secara tidak sengaja.

24

File Shredder 
sang Penghancur

Menghapus file agar tidak dapat dikem-
balikan lagi oleh pihak lain.

26

Fungsi pada JavaScript
Bagian enam tutorial JavaScript
membahas fungsi.

22

Password untuk Folder
Lindungi folder dengan pass-
word agar tidak sembarang

pihak dapat membukanya.

28

Address Book mIRC
Bagaimana memanfaatkan
address book pada program

chat yang populer ini.

17

Fasilitas & Wajah Baru
untuk mIRC
Fasilitas baru apa saja pada

mIRC 6.x dan gunakan resource hacker
untuk mengutak-atik mIRC.

19

Tanggal dengan PHP
Memunculkan tanggal di situs
anda dengan skrip yang

dibuat menggunakan PHP.

14

PostNuke yang CSS
Minded
Kelebihan PostNuke dibanding-

kan PHPNuke adalah PostNuke dapat
menangani data lebih besar. Di sam-
ping itu, PostNuke mudah instalasinya
lewat install.php-nya.

12

Instalasi PHP-Nuke
Manfaatkan PHPMyAdmin dari
PHPTriad untuk menginstal

PHP-Nuke sehingga tidak perlu meng-
gunakan command line.

10
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Email Sebagai Senjata
Dengan pos biasa setiap orang dapat
mengirim surat kaleng. Tapi
bagaimana dengan ‘email kaleng’?
Dapatkan anda menulis email secara
anonim? Lalu apa yang dimaksud
dengan email bomb?

Windows Anda Crash?
Bagaimana mencegah dan mena-
ngani kerusakan sistem operasi
Windows? Apakah selalu harus instal
ulang dengan risiko kehilangan setting
yang telah ada sampai risiko kehi-
langan data?

NMap0
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Pemakai Windows 9x/ME
dan bahkan DOS kini
tidak perlu iri dengan
pemakai Linux atau NT
dalam urusan scanning.

NmN
Neoteker menjawab Neoteker
dalam forum milis NeoTek

Ada Apa di CD NeoTek?
Remote Password Cracking
Hacking dan PC Security
Terdeteksi Sebagai Virus

Daftar Isi CD NeoTek

NeoRagam

Inbox
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FOKUS BULAN INIFOKUS BULAN INI

Menggunakan PHP
Cara Praktis dan Mudah

Menggunakan PHP
Cara Praktis dan Mudah

NeoTNeoTutorutor
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NeoRagam

AdaAda ApaApa didi CCDD NeoTNeoTek?ek?
Fokus bulan ini adalah PHP. Daripada mulai dengan teori, NeoTek langsung
membahas instalasi PHP-Nuke untuk dengan cepat dan mudah membuat
portal sendiri. Adapun di bidang hacking dibahas remote password cracking.

CCDD  NNeeooTTeekk
OOkkttoobbeerr  22000022

ulai di enumerasi,
kegiatan hacking
sudah mulai ber-

sifat intrusif. Bila pada
ffoooottpprriinnttiinngg dan ssccaannnniinngg
baru dalam tahap mencari
sasaran yang dapat diserang,
maka pada enumerasi sudah
didapat sasaran potensial.
Kegiatan enumerasi akan
mendapatkan user account
yang valid yang akan dilan-
jutkan dengan mendapatk-
an password user account
yang valid itu.
Tujuan mendapatkan pass-
word dari user account yang
valid adalah mendapatkan
akses pada sistem (ggaaiinniinngg
aacccceessss) dan umumnya dila-
kukan dengan rreemmoottee
ppaasssswwoorrdd  ccrraacckkiinngg.
Sekali akses didapat, maka
dengan fasilitas login yang
didapatnya, kini hacker su-
dah mendapatkan llooccaall
aacccceessss. Disini hacker ber-
usaha meningkatkan status-
nya (eessccaallaattiinngg  pprriivviilleeggee)
dengan memanfaatkan ke-
lemahan sistem.
Bahasan tentang remote
password cracking memang
tidak sebanyak topik-topik
sebelumnya, namun meru-
pakan mata rantai penting
dalam proses hacking.
Adapun topik penting dalam
CD NeoTek kali ini adalah
PHP scripting dengan apli-
kasi portal PHP yang tang-
guh namun gratis: PHP-
Nuke dan PostNuke. Ter-
sedia untuk Linux maupun
Windows.

Gaining Access
emote password
cracking adalah usaha

untuk mendapatkan akses
(gaining access) pada suatu
sistem.Tekniknya sangat
konvensional, yaitu dictionary
attack atau brute-force attack.
Remote Password

Brutus
Entry LE 2.7
wwwHack
c2myass
Winfo
Xavior

Password Stealer
Cain 2.0 (Win 9x/ME)
Cain 2.5 (Win NT/2K)

NetBIOScanner
Legion 2.1
Network Auditing Tool
SharesFinder
SMBScanner
SMB Audit Tool
SMB Downgrade Att.
SMB Client

Password Cracker
John the Ripper
L0phtcrack 4
SQLDict

Pwdump
Pwunhinder
SAMDump
WinPWL 3.5
Red Button

Escalating Privilege
ekali akses telah didapat,
maka penyerang sudah

mendapatkan local login pada
sistem.Selanjutnya adalah me-
ningkatkan privilege dengan
memanfaatkan kelemahan
yang ada pada sistem.

Sechole
Getadmin

MM

RREEMMOOTTE PE PAASSSWSWOORRD CD CRRAACCKKIINNGG

embali kita mengingat
proses dalam hacking

yang dimulai dengan foot-
printing, scanning, dan dilan-
jutkan dengan enumerasi dan
gaining access, yang dilanjut-
kan dengan escalating privilege
atau local access.

Footprinting
Advanced Dig
NScan
NSLookup
NSQuery
Traceroute
Whois for Windows
Winfingerprint

Scanning
CIS Scanner
GNIT Scanner
Mingsweeper
Nmap 1.30 rpm
Nmapfe 1.30 rpm
Nmap 1.30 DOS
Nmapfe (Win 9x)
Nmap NT

Sniffer
Dsniff 1.8 Windows
Windump 3.62
Windump 3.8
WinPcap 2.3
WinPcap 3.0

Network Tool
Mptraceroute
NB4
NBName
Nbtdump
NetFizz
Netinfo

Security
Steganos Suite
Windump 3.62
Zone Alarm 3.1

HAHACC KK II NN G DG DAN PC SAN PC S EE CC UU RR IITT YY

KK

RR

SS

Terdeteksi Sebagai Virus
Pada CD NeoTek terkadang
terdapat program yang dike-
nali sebagai virus atau trojan
oleh anti-virus
Suatu trojan misalnya, me-
mang tidak merusak kom-
puter anda, namun mem-
buka port tertentu yang me-
mudahkan serangan hacker.
Hal ini biasa dan secara lang-
sung  tidak berbahaya. Na-
mun demikian, sebaiknya
anda memahami mengapa
program itu dianggap ber-
bahaya
AAnnttii--TTrroojjaann
• netbuster1_31.zip
PPaasssswwoorrdd  SStteeaalliinngg  TTrroojjaann
• cain20.exe
• cain25b13.exe
HHaacckkiinngg  TTooooll
• GetAdmin.exe
• sechole.exe
• admin.dll
• gasys.dll
Bila anda tidak memahami
benar cara kerja program
yang disebut di atas, sebaik-
nya sewaktu dikenali oleh
antivirus, program-program
ini dikarantina atau dihapus
dari komputer anda.
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daftar isi cd neotekdaftar isi cd neotek
SERVER & SCRIPTING
Active Perl 5.6.1 ActiverPerl-5.6.1.631
Active Perl 5.6.1 AS ActiverPerl-5.6.1.631
Active Python ActivePython-2.1.1.msi
Active Tcl 8.3.4.2 ActiveTcl8.3.4.2-1-win32-ix86.exe
Apache 2.0.39 Apache_2.0.39-win32-x86-no_ssl.exe
ASP Edit aspedit.zip
JavaScript Editor 2.5 jse2em.exe
JavaScript Editor jdEditor96Install.EXE
Komodo Komodo-1.2.5-33280.msi
Mdaemon mdsetup.exe
Nuke 4.4.0 NUKE440N.ZIP
Perl ASP PerlASPX-1.0.0.3.msi
Perl Development Kit PDK-4.0.0.401.msi
PHP 4.2.2 php-4.2.2-Win32.zip
PHP Coder phpcoder.exe
PHP Easy php404.EXE
PHP Edit PHPEdSetup3x.exe
PHP Nuke 5.6 PHP-Nuke-5.6.tar.gz
PHP NukeThemes OriOn-v1.6.tar.gz
PHP Triad 2.2.1 phptriad2-2-1.exe
POP Mail poparc.exe
Post Nuke 7.4.1 Rogue_714.zip
Post Nuke Theme PHP5_ML_Themes.zip
PWS ws2setup.exe
Sambar 5.0 sambar50.zip
Tcl Pro 1.5.0.2 TclPro1.5.0.2.1-win32-ix86.exe
Visual Perl 1.2 VisualPerl-1.2.0.2089.msi
Visual Python 1.2 VisualPython-1.2.0.2024.msi
vWeb Server vWeb111.exe
wFTPd 32wfd300.zip; 32wfd310.zip
Windows Scripting Host scripten.exe
WinGate wgsetup.exe
Win SMTP stst07b4.zip
Xitami bw3224d9.exe

ANTI HACKER
Net Buster netbuster1_31.zip
Tiny Honey Pot LATEST-IS-thp-0.4.4.tar.gz

ESCALATING PRIVILEGE
Get Administrator getadmin.zip
Sechole sechole2.zip
Win PWL 3.5 WinPWL35.exe

FILE MANAGEMENT
File Recovery Demo FRC-demo.zip
File Shredder Shredder.zip

FOOTPRINTING
Advanced Dig dig04.zip
NScan nscan09.exe
NSLookup nslookup.exe
NSQuerry NSQUERY.zip
Trace Route 02 tracert02.zip
Whois 9x whoisi.exe
Winfingerprint 0.5.0 winfingerprint-0.5.0.zip

NETWORK TOOL
MP Trace Route mptraceroute.zip
NB4 nb4.bat
NBT Dump nbtdump.exe
Net Fizz net-fizzV0.1.zip
Net Info netinfo.zip

SCANNING
CIS Scanner CIS-5.0.02.zip
GNIT Scanner gnit_rc1.zip
Ming Sweeper minger1a5.zip
Nmap Win 1.30 nmapwin_1.3.0.exe

PROJECT
Digital Clock PCB
Mail Server Tiruan
Web Server Tiruan

GAINING ACCESS
Brutus brutus-aet2.zip
C2Myazz c2myazz.zip
Cain 2.5 cain25b13.exe
Entry Light Edition entryle.exe
John Win john-16w.zip
LC4 lc4setup.exe
Legion 2.1 legion.zip
Nat nat10bin.zip
Pop Mail PWCracker popcrack.zip
PWDump 3 pwdump3v2.zip
PWDump Unhider pwdunhider.zip
Red Button 1.0 rb100.zip
Sam Dump samdump.zip
Shares Finder SHARESFINDER.ZIP
SMB Auditing Tool 1.0.4 smbat-win32bin-1.0.4.zip
SMB Client win32-Samba-Clients.zip
SMB Downgrade Attacker downgrade.exe
SMB Scanner smbscanner-eng.zip
SQL Dictionary sqldict.exe
Winfo winfo.exe
WWWHack wwwhack.zip
Xavior XaviorBeta7.exe

SECURITY
Steganos Steganos.exe
Zone Alarm 3.1 zaSetup3101.exe

SNIFFER
DSniff 1.8 Win dsniff-1.8-win32-static.tgz
Win Dump 3.8 WinDump.exe
WinPcap 3.0 WinPcap_3_0.exe
Zone Alarm 3.1 zaSetup3101.exe

JAVA DEVELOPMENT KIT (JDK)
JDK 1.4.0 j2sdk-1_4_0-win.exe

PROGRAM UMUM
Acrobat Reader 5.0.5 ar505enu.exe
Direct X Directx8_1.exe
Internet Explorer 6 ie6setup.exe
Logo Manager lm127.zip
mIRC mirc602.exe
MS Installer MSInstaller.exe
Opera 6.0.1 Opera6_01Java.exe
PDF2HTML pdf2ht14.zip
Resource Hacker 3.4.0 ResHack.zip
Shockwave Player Shock8Flash6Player.exe
Trust Toolbar TrustToolbar.exe
VB Files vbrun6.exe
Windows Media Player 7 WinMediaPlayer7_1.exe
WinZip Winzip8_1.exe
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Inbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTeker menjawab NeoTekerNeoTeker menjawab NeoTeker

ButtSniff Ada Virusnya?
T: Posted July 29
Saya Download file Butt-
sniff dari Neotek, tapi kok
ada virusnya nama virusnya
orifice2k.plugin
Buambang
uhi@tele-net.co.id

J: Posted July 30
Buttsniff dan plug-in BO
lainnya memang akan dike-
nali sebagai virus/trojan oleh
antivirus. Demikian juga BO
atau BO2K akan dikenali
sebagai virus/trojan.
Kosasih Iskandarsjah
kosasih_iskandarsjah@yahoo.com

J: Posted July 30
Tul tuh kata mas kosasih... di-
kategorikan sebagai tools yg
berbahaya... btw saya baru
check virus pake antivirus
online (pc cillin) ternyata
lebih lengkap yah definition
nya... file jokes (dari yg fake
format, fake delete, open
notepad contiuosly, etc etc)
semua kedetek... walau gak
bakal saya delete karena
buat iseng =DD saya pake
nav yg sering di-update aja
gak pernah ketemu (karena
gak pernah scan full hehehe)
Redi Tya K.
green@cbn.net.id

Tentang IP Address
T: Posted July 31
Saya akan berlanggan Inter-
net dengan wavelan, isp ter-
sebut memberikan ip address
sebanyak 8 buah. 3 buah di-
gunakan untuk komputer
yang terhubung ke jaringan
isp (yang menggunakan
wavelan) dan sisanya diguna-
kan untuk client di jaringan
saya. Masalahnya adalah jum-
lah yang lima tadi tidak bisa
menampung jumlah client
jaringan lokal saya yang
berjumlah 100 komputer.
Pertanyaannya:

1. bagaimana caranya meng-
hubungkan seluruh kom-
puter tersebut ke isp

2. apakah harus ada kompu-
ter, khusus untuk gateway
di jaringan lokal saya ter-
sebut? Kalau ada bagaima-
na caranya? Apakah harus
dikonfigurasikan IP adress-
nya padahal untuk jaringan
lokal saya menggunakan:
192.168.0.x,
netmask 255.255.255.0;
sedang isp sebagai gateway:
202.x.x.150,
router 202.x.x.151,
eth0 202.x.x.152;
sedangkan ip yang diberi-
kan isp untuk client di
jaringan saya:
202.x.x.153 s/d 202.x.x.157
netmask 255.255.255.24
Gimana dong caranya?

Sapar Leo
vart730@yahoo.com

J: Posted August 8
1. Di gateway-nya coba ja-

lankan Network Address
Translation (NAT) atau
sering di sebut sebagai
Internet Connection Sharing
bisa juga dibantu meng-
gunakan proxy server

2. Di gateway-nya di pasang
dua interface dengan IP
+ 202.x.x.x
+ 192.168.0.1

Onno W. Purbo
onno@indo.net.id

Mandrake Tidak Bisa
Baca CD ROM dan Floppy
T: Posted August 3
Pada saat roadshow Pak Onno
di Pekanbaru saya mendapat
CD Linux Mandrake 8.2 dan
saya coba instal di komputer
saya. Sebelumnya di kompu-
ter telah saya instal SUSE 8.0.
Masalahnya: saya tidak da-
pat mount CDROM dan
FLOPPY walaupun saya su-
dah login sebagai root. Saya
coba mengakses direktori

/mnt/cdrom, mucul pesan
“you do not have enough
permissions to read file
:/mnt/cdrom.” Padahal saya
SUDAH login sebagai root.
Saya coba dengan Konqueror,
anehnya gambar icon berupa
gambar folder+gembok. Saya
klik kanan lihat propertinya:
Type: locked directory could
not enter directory /mnt/
cdrom. Apa sebabnya?
Jansen Lingga
jansenlingga@telkom.net

J: Posted August 3
Pada Mandrake mount dan
umount dilakukan otomatis.
Bila pada CD ROM drive ada
CD-nya dan pada floppy drive
ada disketnya, secara otomatis
akan mount sendiri.
Paling tidak demikian dengan
Mandrake 8.0 Download
NeoTek edisi khusus Linux
Mandrake 8.0 di sini:
http://www.neotek.co.id/0208
/NTMdk.zip
Kosasih Iskandarsjah
kosasih_iskandarsjah@yahoo.co

J: Posted August 3
Mungkin bisa dicoba:
chmod 777 /mnt/cdrom
(ini agak gila) tapi semoga
manjur :)...
Satu hal lagi, kalau bisa CD
drive-nya dibersihkan. CD
Mandrake pembagian kema-
rin kayanya agak rewel kalau
CD drive-nya kotor...

Onno W. Purbo
onno@indo.net.id

Partisi Mandrake
T: Posted August 5
Kalau boot dr cd Mandrake
neotek, msk ke partisi HDD,
dari total 15Gb, 8 Gb sudah
terisi, sedang yang mau create
untuk Mandrake adl 4 Gb,
apakah partisi yg dibuat se-
cara otomatis di bagian yg
kosong? Soalnya kalau liat

semuanya warna biru (FAT
32) tdk terlihat mana yg su-
dah terpakai atau belum.
Zonny
zonny@dak.bankbii.com

J: Posted August 5
Pilih resize partition. Partisi
Windows yang tadinya 15
Gbyte buat jadi 11 Gbyte.
Caranya dengan menggeser
slot ke kiri (dari 15 jadi 11).
Akan diperoleh 4 Gbyte
kosong (putih) dan ini yang
diisi untuk partisi2 Linux.
Kosasih Iskandarsjah
kosasih_iskandarsjah@yahoo.com

Memakai WinHex
T: Posted August 5
Gue mo crack program, pake
WinHex 10.45 SR-7. Yang
gue kagak ngerti, di petun-
juknya kan gini:
Buka file blabla.dll. Search
this string: 4321 1B5F 5DA2
Replace with that: 4212
BC4A 4ED0
Di WinHex nya ada kolom
bilangan Hexa dari 0 ampe F.
Terus yang pinggir kiri ada
alamatnya dari 00000000
ampe 00081FF0 tiap kolom
hanya terdiri dari 2 digit
misal 24 45 A1 D4 dst. Terus
tugas gue mesti gimana nih?
soalnya di instruksinya suruh
nyari 4321 1B5F 5D2A.
Zonny
zonny@dak.bankbii.com

J: Posted August 5
Sampeyan search aja hexa
yang bersangkutan (4321
1B5F 5DA2), kalo udah
ketemu ganti dengan 4212
BC4A 4ED0. Tapi program
yang diedit versinya harus
sama dengan tutorialnya,
kalo tidak, ada kemungkinan
kode hexa yang dicari tidak
ketemu.
Basuki Rachmat
Basuki.Rachmat@jict.co.id
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3 MEMILIH THEME
Anda akan mendapatkan password
untuk login (dikirim juga melalui email).
Kini dapat login sebagai user melalui
halaman login yang sama dengan
memasukkan user name dan pass-
word yang baru didapat ini, lalu klik
Login. Pada personal page anda, pilih
Theme sesuai selera anda.

ini selain pertemuan di channel
#neoteker di Dalnet, para neoteker
mempunyai media komunikasi

lain, yaitu Neoteker Official Portal.

Pada portal ini setiap neoteker diminta men-
daftar dan dengan demikian mendapatkan
personal page sendiri yang di antaranya
berisi Web email.

Selain dapat berkomunikasi antar-neoteker,
media ini juga merupakan papan pengu-
muman serta arsip untuk kegiatan tutorial
online di #neoteker.

Anda juga dapat mengirim artikel maupun
komentar mengenai kegiatan-kegiatan di
channel #neoteker maupun portalnya.

POPORRTTAL NAL NEEOOTTEEKKEERR
PPEERRLULUAASSAN #NAN #NEEOOTTEEKKEERR
DDEENNGGAN PAN PHHP-NP-NUUKKE CE CMMSS
Suksesnya chatroom #neoteker di Dalnet membuat
komunitas pembaca NeoTek membentuk portal sendiri
untuk ‘papan pengumuman’ sekaligus ‘majalah dinding’
para neoteker. Semua ini dimungkinkan dengan mengguna-
kan PHP-Nuke.

K

KEMBALI KE HOME
Pada Menu Utama klik Home un-
tuk melihat apa saja yang disedia-
kan oleh portal ini. Salah satu peng-
umuman penting yang terlihat
adalah jadwal tutorial online yang
diusahakan akan ada setiap hari
sekitar pk 20.00 atau 21.00 WIB.

KONTRIBUSI ARTIKEL
Sebagai anggota anda dapat me-
nyumbang tulisan berupa berita
maupun artikel. Tulisan yang di-
posting ke portal ini akan disortir
dan diedit dulu sebelum dimuat.
Di sini administrator memang me-
megang kendali penuh atas mana-
jemen isi portal.

MASUK KE PORTAL NEOTEKER
Arahkan browser anda ke situs
NeoTek Official Portal di
http://neotek.portal.dk3.com/
Karena anda baru pertama kali
mengunjungi portal ini, anda
belum terdaftar di sini. Klik Create
One untuk mendaftarkan diri.

USER REGISTRATION/LOGIN
Anda akan masuk ke halaman
User Registration/Login. Pilih New
User Regsitration dan anda dimin-
ta mengisikan Nickame, email,
avatar (ikon yang mewakili
anda), dan lain sebagainya.
Setelah itu klik New User untuk
melanjutkan.

1

4 5

2

Komunikasi antar-neoteker menjadi semakin bermanfaat dengan adanya portal

STATISTIK
Telaah sendiri fasilitas apa saja yang
disediakan oleh portal ini. Salah satu
informasi yang menarik adalah
member list dan statistics. Pada
statistik terlihat sistem operasi dan
browser apa saja yang digunakan
anggota. Juga terlihat bahwa portal
ini menggunakan PHP-Nuke 5.4.

6
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3 DIREKTORI APACHE
PHPTriad akan membentuk direk-
tori C:\Apache yang di bawahnya
terdapat beberapa subdirektori.
Yang menjadi perhatian kita adalah
subdirektori htdocs, mysql, dan php.
Apache.exe itu sendiri terletak pada
direktori C:\Apache.

uatu portal dengan banyak fungsi
dapat dibuat dengan mengguna-
kan PHP. Karena PHP bersifat

cross-platform, maka dapat dioperasikan
pada berbagai macam sistem operasi, di
antaranya Linux dan Windows.

Kini untuk membentuk portal dengan ba-
nyak macam fungsi seperti forum diskusi,
sumbangan artikel, email, personal page,
serta lain sebagainya, anda tinggal meng-
instal CMS (content management system)
yang ditulis sepenuhnya dalam PHP dan
tersedia sebagai software open source: PHP-
Nuke dan PostNuke

Untuk instalasi PHP-Nuke atau PostNuke,
di komputer anda harus telah terinstal
Apache web server, PHP, dan basisdata

PPHHPTPTRRIADIAD
PPEERRSSIAPIAPAN IAN INNSSTTALALAASSII
PPHHP-NP-NUUKKE DE DAN POAN POSSTTNNUUKKEE
Untuk menginstalasi PHP-Nuke atau PostNuke, terlebih dulu
pada komputer anda telah terpasang Apache web server, PHP
versi 4 ke atas, serta database seperti MySQL atau PostgreSQL.
Semuanya dapat dengan mudah terinstalasi dengan PHPTriad,
tanpa harus memusingkan konfigurasi server Apache.

S

PHPINFO.PHP
Jalankan phpinfo.php yang ada di
direktori C:\apache\htdocs melalui
browser dengan memasukkan URL:
http://localhost/phpinfo.php. Terlihat
bahwa PHPTriad menggunakan PHP
versi 4.1.1. yang berarti dapat digu-
nakan untuk menjalankan PHP-
Nuke atau PostNuke.

PHPTRIAD CONTROL PANEL
Pilih Start > Programs > PHPTriad >
PHPTriad Control Panel yang akan
membuka browser untuk mengen-
dalikan berbagai aspek PHPTriad
(Apache, PHP, dan MySQL) melalui
Web interface. Pada dasarnya anda
sudah mempunyai suatu Web ser-
ver berbasis PHP yang berjalan.

MEMULAI INSTALASI
Download phptriad2-2-1.exe (ver-
si terakhir) dari Sourceforge di
http://sourceforge.net/projects/
phptriad atau dapatkan dari CD
NeoTek bulan ini. Double-click
ikon-nya dan instalasi akan
dimulai dengan menampilkan
License Agreement. Klik I Agree.

EKSTRAKSI DAN SETUP
Proses ekstraksi dan setup akan
berjalan secara otomatis. Anda
dapat melihat proses dengan
mengklik Show details. Setelah
selesai, klik tombol Close dan
instalasi pun selesai!

1

7 8

2

Instalasi PHPTriad sebagai persiapan instalasi PHP-Nuke dan PostNuke

MENU-MENU CONTROL PANEL
Selain setup dan manage Apache,
anda dapat mengelola situs anda
dari sini (Manage Site), start/stop
database MySQL (MySQL), meng-
edit konfigurasi PHP (PHP), serta
Help. Pada Manage Site anda
dapat menjalankan PHPMyAdmin
serta backup situs/konfigurasinya.

9
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MySQL. Ketiga komponen ini dapat
diinstal secara terpisah, lalu mengedit
file-file konfigurasinya agar ketiganya
dapat bekerja bersamaan.

Kali ini kita gunakan cara yang paling
mudah yaitu menginstal PHPTriad yang
akan secara otomatis menginstal Apache
web server, PHP, dan MySQL. Ketiga-
nya sudah terhubung untuk beroperasi
bersamaan serta dilengkapi dengan
PHPMyAdmin untuk mempermudah
manajemen ketiga komponen tersebut.

Berikut dijelaskan konfigurasi httpd.conf
di folder Apache yang menghubungkan
Apache dengan PHP. Masuk ke direktori
C:\apache\conf dan buka file hhttttppdd..ccoonnff
dengan Wordpad.

Cari bagian-bagian ini, yang merupakan
konfigurasi yang menghubungkan Apa-
che dengan PHP:

SSccrriippttAAlliiaass  //pphhpp//  ""cc:://aappaacchhee//pphhpp//""
memberikan keterangan pada apache
web server, bahwa /apache/php/
adalah alias dari direktori tempat php
diinstall, yaitu c:/apache/php.

AAddddTTyyppee  aapppplliiccaattiioonn//xx--hhttttppdd--pphhpp  ..pphhpp
Memberikan MIME PHP kepada
Apache, yaitu semua file php
berekstensi *.php

AAccttiioonn  aapppplliiccaattiioonn//xx--hhttttppdd--pphhpp  ""//pphhpp//pphhpp..eexxee""
Memberitahukan Apache bahwa
untuk file MIME PHP, action yang
harus dilakukan adalah memanggil

program php.exe.

Bagian-bagian berikut dapat diganti
sesuai keinginan Anda:

SSeerrvveerrAAddmmiinn  aaddmmiinn@@llooccaallhhoosstt
DDooccuummeennttRRoooott  ""CC:://AAppaacchhee//hhttddooccss""
SSeerrvveerrNNaammee  llooccaallhhoosstt
berturut-turut adalah alamat e-mail
webmaster, tempat halamanan-
halaman web, serta nama server.

Bila anda mempunyai DNS sendiri, mi-
salnya neotek.co.id, maka SSeerrvveerrAAddmmiinn
dapat menjadi admin@neotek.co.id,
SSeerrvveerrNNaammee  menjadi neotek.co.id, dan
DDooccuummeennttRRoooott dapat diatur di mana saja.

Penulis (Asmuri Anwar) dapat dihubungi
melalui asmuri@persda.co.id.

PHPMYADMIN
Klik Launch PHPMyAdmin dan
anda akan masuk ke halaman
Welcome to phpMyAdmin yang di
sini anda dapat mengelola data-
base MySQL seperti melihat da-
tabase yang ada, membuat basis-
data baru, serta menghapus basis-
data. Pilih Database Statistics.

DATABASE MASIH KOSONG
Tampak bahwa belum ada basis-
data yang dibentuk kecuali basis-
data awal MySQL. Di sinilah tem-
pat anda menghapus (drop)
basisdata sebelum menginstal
ulang PHP-Nuke atau PostNuke
(bila instalasi pertama kurang
memuaskan).

PADA START MENU
Adapun pada Start menu terben-
tuk entri PHPTriad yang terdiri dari
empat submenu: Apache Console,
MySQL, Config and Data Backup,
serta PHPTriad Control Panel. Pada
Apache Console ada lagi tiga pilih-
an: Restart Apache, Start Apache,
dan Stop Apache.

MENJALANKAN APACHE
Pilih Start > Programs > PHPTriad
> Apache Console > Start Apache
untuk menjalankan Apache server.
DOS console akan tampil yang
menginformasikan bahwa Apache
Web server sudah berjalan. Untuk
menghentikan Web server ini pilih
Stop Apache dari menu yang ada.

4

10 11

5 SERVER LOCALHOST
Karena Apache web server terpa-
sang pada komputer lokal, maka
buka browser (misalnya IE) dan
buka URL: http://localhost dan
terlihat inilah halaman web
index.html yang ada pada root di
komputer anda, yaitu di direktori
C:\apache\htdocs

6

MEMILIH BAHASA
Dari phpMyAdmin juga anda da-
pat memilih bahasa yang akan
digunakan dalam menjalankan
phpMyAdmin. Setelah memahami
PHPTriad, kita lanjutkan dengan
instalasi PHP-Nuke.

12
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3 GUNAKAN PHPMYADMIN
Sebagai pengganti command line,
buka Start > Programs > PHPTriad
> PHPTriad Control Panel yang
akan membuka halaman Web
phpMyAdmin. Pilih Launch
PHP_MyAdmin dan perhatikan
setting bagian kiri (MySQL).

esulitan para pemakai Windows
bila berhadapan dengan software
pada Linux atau yang berasal dari

dunia open source adalah penggunaan
command line.

PHPTriad bukan saja memudahkan instalasi
sekaligus Apache Web server, PHP, dan
basisdata MySQL, melainkan juga memu-
dahkan instalasi PHP-Nuke yang ‘aslinya’
dijalankan pada Linux.

Fasilitas PHPMyAdmin pada PHPTriad mem-
berikan interface Web untuk berbagai hal
penting sehubungan dengan Apache web
server, konfigurasi PHP, maupun basisdata
MySQL. Pembentukan basisdata MySQL
maupun pengisian tabel terhadap basisdata
itu dilakukan dengan bantuan interface grafis.

PPHHP-NP-NUUKKEE
COCONNTTEENNT MANAT MANAGGEEMMEENNTT
SSYYSSTTEEM BM BEERRBBAASSIIS PS PHHPP
Jangan gentar dulu membaca petunjuk instalasi PHP-Nuke
yang seolah-olah hanya dapat menggunakan command line.
Fasilitas PHPMyAdmin pada PHPTriad memungkinkan
semua itu dilakukan melalui GUI yang sangat lazim bagi
pengguna Windows.

K

MEMBENTUK TABEL
Kini pada kotak isian di bawah
Location of the textfile telah terisi
path ke file nuke.sql. Kini anda
tinggal mengklik tombol Go untuk
mengisikan tabel-tabel yang ada
pada file teks nuke.sql ke
basisdata nuke.

SQL QUERY MENGISI TABEL
Akan tampil halaman web yang
menginformasikan bahwa pada ba-
sisdata nuke kini telah terdapat 65
tabel yang berasal dari nuke.sql, di
antaranya nuke_access, nuke_author,
dan lain-lain yang terlihat juga pada
kolom sebelah kiri.

MEMULAI INSTALASI
Download PHP-Nuke-5.4.tar.gz
(tersedia pula versi 5.5 dan 5.6)
dari http://www.phpnuke.org/ atau
dapatkan dari CD NeoTek bulan
ini. Double-click ikonnya dan file
ini akan dibuka oleh WinZip.
Ekstrak ke direktori baru
C:\apache\htdocs\phpnuke

PETUNJUK INSTALASI
Lihat petunjuk instalasinya yaitu
file install yang terdapat di direktori
C:\apache\htdocs\phpnuke. Buka
file ini dengan Wordpad dan terte-
ra di situ bahwa anda harus mem-
bentuk suatu basisdata, misalnya
nuke dengan perintah command
line mysqladmin create nuke

1

7 8

2

Instalasi PHP-Nuke menjadi sangat mudah dengan PHPMyAdmin

MENJALANKAN MYSQL
Kembali ke PHPMyAdmin dan
pilih Start MySQL. Ada dua pilihan
di sini, bergantung sistem operasi
yang digunakan yaitu NT/W2K/XP
atau 95/98/ME. Akan tampil pe-
san bahwa MySQL telah dijalan-
kan.

9
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PHP-Nuke didistribusikan dalam for-
mat tarball (*.tar.gz) dan karena ber-
sifat cross-platform, dapat diinstal baik
pada Linux maupun pada Windows.

Pada Linux, melalui command line,
ketikkan:

ttaarr  --zzxxvvff  PPHHPP--NNuukkee--55..44..ttaarr..ggzz

untuk mengekstraksi isinya ke direk-
tori PHP-Nuke-5.4. Adapun pada Win-
dows, file tarball yang sama dapat di-
ekstraksi dengan WinZip dan ditem-
patkan di direktori pilihan anda.

Akan terbentuk file nnuukkee..ssqqll yang ber-
isi perintah-perintah untuk memben-
tuk struktur basisdata yang diperlukan
untuk menjalankan PHP-Nuke.

Bentuk database kosong dengan nama
nuke, yang perintahnya pada command
line Linux adalah:

mmyyssqqllaaddmmiinn  ccrreeaattee  nnuukkee

Kemudian isi database kosong ini de-
ngan tabel-tabel yang ada pada file
nnuukkee..ssqqll  (file ini ada di bawah subdirek-
tori sql). Perintahnya dalam command
line Linux adalah:

mmyyssqqll  nnuukkee  <<  nnuukkee..ssqqll

Pada Linux access permission dari file
harus diubah dengan perintah chmod.
Pada semua file gunakan cchhmmoodd  666666
dan pada semua direktori cchhmmoodd  777777.
Pemakai Windows tidak usah memu-
singkan hal ini.

Selanjutnya apabila perlu, opsi-opsi
basisdata dapat ditetapkan dengan meng-
edit file ccoonnffiigg..pphhpp. Silakan baca sen-
diri petunjuknya. Untuk opsi standar
pada contoh ini tidak ada perubahan
apa-apa.

Instalasi PHP-Nuke pada Windows di
bawah PHPTriad akan sangat mudah,
sebab semuanya menggunakan inter-
face grafis.

Semua orang kini dapat mempunyai
PHP portal sendiri, tanpa harus mem-
pelajari terlebih dahulu HTML mau-
pun PHP (apalagi CSS), walaupun
kesemuanya itulah dasar yang mem-
bentuk portal berbasis PHP ini.

PORTAL ANDA TERBENTUK!
Portal PHP-Nuke anda telah ter-
bentuk! Buka browser, masuk ke
http://localhost/phpnuke/html dan
akan tampil halaman selamat
datang dari PHP-Nuke. Klik link
Administrator page untuk me-
lihat fitur apa saja yang ada
pada PHP-Nuke.

SEBAGAI ADMNISTRATOR
Secara default, user name untuk
administrator adalah God se-
dangkan password-nya adalah
Password. Perhatikan  banyaknya
fitur yang tersedia pada portal
PHP gratis ini: Add Story,
Backup DB, Blocks, dan lain-lain.

MEMBENTUK DATABASE
Pada halaman Web Welcome to
phpMyAdmin, ditunjukkan bahwa
anda sebagai root sedang menja-
lankan MySQL 3.23.47-max-debug.
Pada kotak isian Create new data-
base ketikkan nuke, lalu klik Create
untuk membentuk basisdata MySQL
dengan nama nuke.

DATABASE ‘NUKE’ TERBENTUK
Basisdata nuke terbentuk, namun
belum ada tabel apa pun pada
basisdata ini. Kembali ke petunjuk
dikatakan anda harus mengisi
basisdata ini dengan tabel yang
terdapat pada file nuke.sql

4

10 11

5 MENGAMBIL NUKE.SQL
Klik tombol Browse yang berada
di sebelah kanan “Location of the
text file” dan dapatkan file
nuke.sql yang berada di direktori
C:\apache\htdocs\phpnuke\sql lalu
pilih file itu dan klik Open

6

MEMILIH THEME
Daftarkan diri anda sebagai salah
seorang user biasa. Anda akan
mendapatkan password untuk
login dan anda mempunyai
halaman Web sendiri yang dapat
anda pilih sendiri Theme-nya. Di
sini sebagai contoh adalah Theme
3D-Fantasy.

12
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3 FILE UNTUK INSTALASI
Sedangkan file untuk instalasi, yaitu
install.php terdapat pada direktori
C:\apache\htdocs\pc_714\html.
Jalankan Apache web server
dengan memilih Start > Programs
> PHPTriad > Apache Console >
Start Apache. Lalu buka browser
anda.

nstalasi PostNuke pada Linux mau-
pun Windows sangat mudah, yaitu
dengan menjalankan iinnssttaallll..pphhpp

dari web browser anda. Tentu saja untuk
menjalankan ini Apache Web server sudah
harus berjalan.

PPoossttNNuukkee dikembangkan dari PPHHPP--NNuukkee  55..00
dengan lebih memanfaatkan CSS sehingga
lebih tangguh untuk menangani data dalam
jumlah besar.

Masih terdapat satu lagi produk, yaitu
mmyyPPHHPPNNuukkee  yang merupakan percabangan
dari PPHHPP--NNuukkee  44..44. myPHPNuke tidak
dibahas dalam NeoTek kali ini.

PostNuke hanya berjalan pada PHP 4 ke
atas dan struktur basisdata-nya berbeda
dengan struktur basisdata PHP-Nuke.

POPOSSTTNNUUKKEE
PPEERRCCABABANANGGAN PAN PHHP-NP-NUUKKEE
YYANANG LEG LEBBIIH CH CSSS-MS-MIINNDDEEDD
PostNuke dikembangkan dari PHP-Nuke dengan lebih
memperhatikan pemanfaatan CSS (cascading stylesheet)
sehingga dapat lebih tangguh untuk menangani data dalam
jumlah besar. PostNuke tersedia untuk Linux dan Windows,
dan instalasi pada Windows sudah sangat otomatis.

I

KONFIRMASI
Anda diminta untuk mengkonfir-
masi pilihan-pilihan tadi. Bila
ingin mengubah, klik Change Info.
Bila tidak, klik New Install (bila
sudah menggunakan PostNuke
versi sebelumnya, klik Upgrade).

CREATE DATABASE
Selanjutnya anda akan mendapat-
kan halaman New Install. Di sini
pastikan bahwa kotak Create
Database di-tick. Selanjutya klik Start
untuk membentuk basisdata.

MEMULAI INSTALASI
Download Rogue_714.zip (Windows)
dari http://www.postnuke.com/
atau dapatkan dari CD NeoTek
bulan ini. Double-click ikonnya
dan file ini akan dibuka oleh
WinZip. Ekstrak ke direktori baru
C:\apache\htdocs\

FOLDER PN_714 TERBENTUK
Akan terbentuk folder pn_714 yang
di bawahnya terdapat subfolder
html dan sql. Petunjuk instalasi
terdapat pada file INSTALL di
direktori C:\apache\htdocs\pn_714 

1

7 8

2

Instalasi PostNuke pada PHPTriad bahkan lebih otomatis lagi.

DATABASE ROGUE TERBENTUK
Basisdata Rogue (yang menggu-
nakan informasi tabel dari file
rogue.sql akan terbentuk. Terlihat
berbagai tabel yang dibentuk dan
pada  bagian paling bawah ter-
dapat tombol Continue. Klik
Continue.

9
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Dalam mengisi basisdata kosong, apa-
bila pada PHP-Nuke disediakan file
nnuukkee..ssqqll, maka pada PostNuke dise-
diakan file rroogguuee..ssqqll.

Theme pada PotNuke dapat juga di-
gunakan pada PHP-Nuke, walaupun
beberapa feature CSS-nya tidak dapat
dimanfaatkan pada PHP-Nuke. Pada
PHP-Nuke theme, warna ditetapkan
langsung (hard coded) sedangkan pada
PostNuke melalui variabel.

SETTING ADMINISTRATOR
Selanjutnya anda mendapakan
halaman web untuk men-set
login administrator. Tetapkan
login name, nama administrator
sebenarnya, password (dua
kali), email administrator, dan
local URL.

INSTALASI SELESAI
Instalasi selesai. Klik Finish dan
anda mendapatkan halaman Web
yang meminta anda membaca
credit file, yaitu siapa-siapa yang
berjasa dalam pengembangan
PostNuke. Klik Go to your postnuke
site. Sebelumnya pastikan bah-
wa MySQL sudah berjalan.

INSTALASI LEWAT BROWSER
Jalankan install.php yang ada pada
localhost dengan mengetikkan:
http://localhost/pn_714/html/
install.php. Anda akan masuk ke
halaman awal PostNuke Installation
yang dimulai dengan Select Language.
Klik di situ dan anda akan masuk
ke halaman lisensi. Klik Next.

SETTING CMOD
PostNuke akan memastikan bah-
wa setting pada file config.php
dan config-old.php adalah 666,
yang artinya sewaktu proses
instalasi dapat di-write ke hard
disk.

4

10 11

5 SUBMIT DATABASE INFO
Secara default PostNuke akan
memilih database host: localhost,
database username: root,
database passeord: (kosong),
database name: Rogue, table
prefix: nuke, dan tipe database:
MySQL. Klik Submit bila tidak ada
perubahan.

6

HALAMAN AWAL POSTNUKE
Anda dibawa ke halaman awal
PostNuke, dalam contoh ini:
http://localhost/pn_714/html.
Silakan eksplorasi sendiri portal
berbasis PHP ini. Coba login
sebagai admin maupun user
biasa.

12

• Selesai instalasi anda diingatkan untuk menghapus file install.php serta direktori install, agar
user biasa tidak dapat mengambil password dari basisdata anda.

Penulis (Asmuri Anwar) dapat
dihubungi melalui asmuri@persda.co.id.
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ULISAN INI TIDAK DIMAKSUDKAN UNTUK membahas
PHP secara mendetail dari dasar-dasarnya, tetapi
sesuai dengan topiknya tulisan ini hanya bersifat

ulasan secara praktis terhadap aplikasi-aplikasi yang ditulis
dengan PHP. Tulisan ini terbagi menjadi tiga bagian utama,
yaitu dasar teori, pembahasan aplikasi dan referensi serta
perbendaharan fungsi.

Pada dasar teori akan dibahas secara singkat saja apa-apa
yang akan dipakai dalam aplikasi, tentunya jika teori ter-
sebut belum disebutkan sebelumnya. Dalam pembahasan
aplikasi yang merupakan pokok tulisan akan dibahas ten-
tang aplikasi yang disebutkan pada judul, sedangkan bagian
akhir berisi refenrensi serta daftar fungsi yang baru.

Dasar Teori

PHP, Apakah itu?
PHP singkatan dari Personal Homepage Program (Hyper-
text Preprocessor), merupakan salah satu jenis scripting
language yang dieksekusi pada sisi server, atau biasa di
sebut server-side scripting. PHP diperkenalkan pertama
kali oleh Rasmus Lerdorf pada tahun 1995, dan berkem-
bang dengan sangat pesat karena kuatnya dukungan dari
para penggunanya.

PHP dan HTML
Skrip-skrip PHP dituliskan menyatu dengan dokumen
HTML. Statement-statement dituliskan langsung pada
dokumen dengan menggunakan tag pengapit <? … ?> atau
<?php … ?>

Contoh sederhananya terlihat pada boks berikut yang me-
rupakan contoh dokumen HTML yang mengandung PHP.
Simpan source tersebut dalam format PHP File (*.php)
misal ppeerrttaammaa..pphhpp. Lalu jalankan dengan browser. Ingat,
anda harus menggunakan server untuk mengeksekusi
PHP!

Keterangan:
Fungsi echo() digunakan untuk menuliskan pada dokumen.

Syntax PHP
Beberapa hal yang terkait dengan penulisan file PHP yaitu

a. File PHP menrupakan file teks biasa sehingga dapat
dituliskan dengan editor teks biasa seperti Notepad,
namun akan lebih baik jika anda menggunakan editor
PHP khusus seperti PPHHPPEEdd atau PPHHPP  CCooddeerr..

b. Seluruh blok skrip PHP harus berada di antara tag

TTanggal Hari Inianggal Hari Ini
PHP atau Personal Homepage Program adalah scripting language yang dieksekusi pada sisi server.

Melalui rangkaian artikel “PHP Praktis,” NeoTek kali ini dan di nomor-nomor mendatang akan menyajikan
teori dan cara pembuatan PHP untuk anda yang ingin mengenal dan mempraktikkannya.

<html>
<head>
<title>File PHP sederhana</title>
</head>
<body>
<?php
echo "Selamat datang di dunia PHP!"
?>
</body>
</html>

<?php
//… script PHP
?>

//atau
<?
//… script PHP
?>

//atau
<script language="php">
//… script PHP
</script>

//atau
<%
//…script PHP
%>

PPHHP PrP Praktis dalam Aplikasiaktis dalam Aplikasi

T
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pengapit <?php … ?> atau tag <? … ?>. Tag ini dapat
juga diganti dengan tag <script>, ditambah dengan
atribut language yang diberi value PHP. Serta dapat
dituliskan pula dengan tag pengapit (delimiter) ASP <%
… %>. Sintaksnya dapat dilihat pada boks contoh kedua
di halaman sebelumnya.

c. Setiap statement harus dipisahkan dengan tanda titik
koma (;), kecuali baris statement terakhir.

d. Semua file yang mengandung skrip PHP harus disim-
pan dalam format PHP File (*.php, *.phtml atau *.php3)

Variabel
Dalam PHP penulisan variabel bersifat khas. Nama variabel
selalu ditulisakan dengan diawali ttaannddaa  ddoollaarr  (($$)) yang lang-
sung diikuti nama variabel, seperti contoh di bawah ini.

Yang harus diperhatikan dalam menamai variabel :

a. Nama variabel selalu diduhui dengan tanda dolar ($)
b. Nama variabel dapat terdiri dari angka, huruf dan

underscore serta kombinasi ketiganya.
c. Nama variabel bersifat case-sensitif, sehingga besar kecil-

nya huruf membedakan variabel yang satu dengan yang
lain.

d. Varabel dideklarasikan langsung ketika suatu nilai dibe-
rikan pada variabel tersebut, sehingga variabel yang
belum ada nilainya tidak akan terdeklarasi.

Percabangan dengan Switch
Sebagaimana umumnya bahasa pemrograman atau script-
ing, percabangan merupan salah satu dari 3 alur dasar da-
am PHP. Dalam PHP, percabangan dapat dilakukan dengan
menggunakan:

a. Statement If
b. Statement If … else
c. Statement switch

Kali ini kita akan menggunakan percabangan dengan meng-
gunakan Statement switch. Statement ini biasanya diguna-
kan untuk percabangan yang memiliki banyak opsi pilihan
yang akan dieksekusi.

Berikut adalah sintaks percabangan yang menggunakan
statement switch:

Statement break di atas digunakan untuk mencegah ada-
nya kemungkinan eksekusi  secara otomatis terhadap case
sesudahnya.

Fungsi-Fungsi Tanggal
Dalam PHP telah tersedia fungsi-fungsi built-in, yaitu fungsi-
fungsi siap pakai yang dapat digunakan untuk membuat
aplikasi-aplikasi sesuai kebutuhan. Kali ini kita berkenalan
dengan fungsi-fungsi yang berkaitan dengan tanggal.

Beberapa fungsi tanggal yaitu :

a. ddaattee((ffoorrmmaatt)),, untuk memberikan nilai waktu saat ini
tergantung format apa yang diinginkan.

Berikut adalah format-format yang dapat dipakai:

Contoh penggunaan:
Misal akan menampilkan sekarang ini bulan apa dapat
digunakan sebagai berikut 

$bulan = date(M);

Maka hasilnya “Mar,” misalnya.

b. ggeettddaattee((kkeeyy)), untuk memberikan waktu sekarang dalam
bentuk array assosiatif tergantung key yang dimasukkan.

Key-key yang dapat dipakai yaitu:

Contoh penggunaan:
Misal ingin menampilkan nama hari, maka dapat
dinyatakan sebagai berikut
$hari = getdate("month");
Hasilnya misalnya saja Sunday.

c. ggmmddaattee((ffoorrmmaatt)), sama dengan fungsi date(), hanya saja
yang dihasilkan adalah waktu GMT. Format-formatnya
bisa dilihat dari fungsi date().

d. ggeettddeesscceenntt((kkeeyy)),, memberikan waktu hari ini dalam
bentuk array assosiatif tergantung key yang dimasukkan.

Key-key yang dapat digunakan :

Switch(variabel yang dikondisikan){
Case nilaivariabel1 : 

…statement PHP1;
break;

Case nilaivariabel2 : 
…statement PHP2;
break;

Case nilaivariabel3 : 
…statement PHP3;
break;

}

$namavariabel1
$namavariabel2

Key Deskripsi

"seconds" Detik
"minutes" Menit
"hours" Jam
"mday" Hari dalam sebulan
"wday" Hari dalam seminggu
"mon" Bulan
"year" Tahun
"yday" Hari dalam setahun
"weekday" Nama Hari 
"month" Nama Bulan

Format Deskripsi

a "am" atau "pm"
A "AM" atau "PM"
d Tanggal, "01" sampai "31"
D Hari
F Bulan
h Jam "01" sampai "12"
H Jam "00" sampai "23"
g Jam "1" sampai "12"
G Jam "0" sampai "23"
i Menit "00" sampai "59"
j Tanggal "1" sampai "31"
l Hari
m Bulan, "01" sampai "12"
n Bulan, "1" sampai "12"
M Bulan, "Jan" sampai "Dec"
s Detik, "00" sampai "59"
t Jumlah hari dalam sebulan, "28" sampai "31"
Y Tahun, 4 digit
y Tahun 2 digit
z Jumlah hari dalam satu tahun

Key Deskripsi

"sec" Second
"usec" Microsecond
"minuteswest" Minutes west of Greenwich
"dsttime" Type of dst coorection
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e. ggeettttiimmeeooffddaayy((kkeeyy)), memberikan waktu sekarang dalam
bentuk assosiatif.

Key yang digunakan sama dengan fungsi getdescent()

f. ggmmmmkkttiimmee((jjaamm,,  mmeenniitt,,……)), memberikan UNIX timestamp.

Pembahasan Aplikasi
Aplikasi tanggal hari ini, memang bukanlah aplikasi yang
terlalu penting, tetapi dapat dijadikan sebagai pelengkap
atau pemanis untuk situs. Biasanya disisipkan di bagian
atas situs, sehingga pengunjung situs dapat dengan mudah
mengingat hari apa saat dia mengakses. Source code-nya
sangat sederhana. Silakan coba source code berikut:

Skrip di atas jika dijalankan pada browser maka akan didapat
keluaran dalam format Hari, Tanggal Bulan Tahun.
Contoh: Rabu, 1 Mei 2002.

Keterangan alur program:
Aplikasi pertama kali dimulai dengan mendeklarasikan 4
vvaarriiaabbeell  uuttaammaa yang akan digunakan untuk menyimpan
data yaitu variabel $hari untuk menyimpan nama hari,
$tanggal untuk menyimpan tanggal. $bulan untuk menyim-
pan nama bulan, serta $tahun untuk menyimpan tahun.

Variabel $hari kemudian diisi dengan nama hari dalam satu
minggu yang diperoleh dari fungsi ddaattee(()) dengan menggu-
nakan format l (huruf L kecil). Nama hari yang diperoleh
adalah nama hari dalam seminggu dalam bahasa Inggris.
Variabel $tanggal diisi dengan dengan tanggal antara 1
sampai 31 yang diperoleh juga dengan fungsi ddaattee(()), hanya
saja dengan menggunakan format j. Jika  anda menghen-
daki tanggal dengan tampilan dari 01 sampai dengan 31
dapat menggunakan format dd. (Lengkapnya silakan lihat
tabel pada bagian Dasar Teori). Variabel $bulan kemudian
diisi dengan nomor urut bulan dalam satu tahun dari 1

sampai dengan 12 yang diperoleh dengan fungsi ddaattee(())
dengan format nn. Format seperti ini diambel untuk lebih
memudahkan saat konversi nantinya. Sedangkan yang
terakhir yaitu variabel $tahun diisi dengan nilai tahun
dalam 4 digit yang diperoleh dengan fungsi ddaattee(()) dengan
memakai format YY (huruf y besar).

Bagian berikutnya adalah konversi nama hari dengan
menggunakan statement sswwiittcchh(()). Nama hari ini kita akan
konversi dari bahasa Inggris ke bahasa Indonesia, jika anda
memang menghendaki tetap dalam bahasa Inggris maka
bagian ini dapat dihilangkan. Demikian juga dengan bagian
konversi nomor bulan menjadi nama bulan.

Selanjutnya setelah semua variabel terisi dengan nilai-nilai
yang sesuai dengan yang kita inginkan, saatnya untuk
menggabungkan nilai-nilai tersebut sehingga menjadi satu
kesatuan yang dapat ditampilkan di situs kita. Format yang
kita pakai di sini adalah Hari, Tanggal Bulan Tahun.
Penggabungan semua variabel dilakukan dengan tanda
kutip, jadi dengan menganggap variabel-variabel sebagai
bagian dari string yang baru. Kemudian langsung akan
dituliskan ke dalam dokumen dengan statement echo().

Source kode di atas dapat langsung di-copy lalu di-paste ke
bagian mana tanggal akan diletakkan dalam dokumen HTML
atau dapat juga dengan cara menyimpannya sebagai file
tersendiri, lalu memanggilnya dengan statement include().
Statement include tidak akan dibahas pada bagian ini akan
tetapi akan dibahas pada bagian mendatang.

Referensi
http://www.php.net 
Situs resmi PHP. Anda dapat mendownload PHP Manual
dari sini.

Daftar Fungsi Baru:

<?php
$hari=date(l);
$tanggal=date(j);
$bulan=date(n);
$tahun=date(Y);
switch($hari){
case "Sunday":
$hari="Minggu";
break;
case "Monday":
$hari="Senin";
break;
case "Tuesday":
$hari="Selasa";
break;
case "Wednesday":
$hari="Rabu";
break;
case "Thursday":
$hari="Kamis";
break;
case "Friday":
$hari="Jumat";
break;
case "Saturday":
$hari="Sabtu";
break;
}
switch($bulan){
case "1":
$bulan="Januari";
break;
case "2":
$bulan="Februari";
break;

case "3":
$bulan="Maret";
break;
case "4":
$bulan="April";
break;
case "5":
$bulan="Mei";
break;
case "6":
$bulan="Juni";
break;
case "7":
$bulan="Juli";
break;
case "8":
$bulan="Agustus";
break;
case "9":
$bulan="September";
break;
case "10":
$bulan="Oktober";
break;
case "11":
$bulan="November";
break;
case "12":
$bulan="Desember";
break;
}
echo "$hari, $tanggal $bulan
$tahun";
?>

Echo Echo("String");
Echo "String";
Echo $variabel

Menuliskan pada
dokumen HTML.

Date Date(format) Menghasilkan
waktu saat ini.

Getdate Getdate(key) Menghasilkan waktu
sekarang dalam ben-
tuk array asosiatif.

Getdescent Getdesecent(key) Menghasilkan waktu
sekarang dalam
bentuk array
asosiatif.

Gmdate Gmdate(format) Menghasilkan waktu
sekarang dalam GMT

Nama Fungsi Sintaks Fungsi

Gmmktime Gmmktime(key) Menghasilkan UNIX
timestamp.

Include Include (“nama_file”);
Include “nama_file”

Menyertakan file
tertentu untuk
dieksekusi.

Catatan:

PHP adalah suatu server-side scripting. Untuk menguji
skrip yang anda buat, pada komputer anda sudah harus

terpasang server seperti PWS, Apache, atau 
internal server pada PHPEd.
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UDAH CUKUP BANYAK ULASAN,
artikel maupun tutorial yang
diberikan NeoTek yang ber-

kaitan dengan program chat mIRC.
Kali ini penulis mengajak sekaligus
menunjukkan pembaca cara menggu-
nakan salah satu dari sekian banyak
fasilitas yang diberikan mIRC ini,
yaitu aaddddrreessss  bbooookk.

Tentang Address Book mIRC
Address book memungkinkan kita
mengetahui dengan cepat nama dan
alamat teman bicara kita—selain
whois. Kita juga dapat memasukkan
picture (gambar) ke dalam address
book. Selain itu, dengan adanya
“notify” kita juga dapat segera tahu,
apakah teman kita sudah OL (online)
atau terkoneksi dengan server chat,
walaupun dia belum masuk ke channel.

Untuk mengaktifkan atau menjalan-
kan Address Book mIRC, kita dapat
memilih salah satu dari tiga cara
berikut:

• tekan [ALT] + B
• pada menu bar, klik Tools → Address.
• mengklik ikon Address Book   di

antara ikon Colors dan dcc send
pada button list.

Pada Address Book akan terlihat be-
berapa ssuubbffoollddeerr di antaranya:

address, info, notify, control dan nick.
Di sini akan dijelaskan satu per satu
fungsi subfolder tersebut.

Address
Adalah tempat data dari nniicckk yang
akan kita ketahui atau kita catat pada
mIRC kita. Bagian ini adalah bagian
yang sering digunakan orang, karena
banyak dimulai dari sini opsi-opsi
yang lainnya.

Pada address ini kita juga dapat me-
nambahkan foto orang tersebut. Cara
memasukkan pic, yaitu dengan meng-
klik bagian tulisan abu-abu  “Click
here to select a picture.”

Setelah diklik tinggal mengarahkan
(browse) pada bagian tempat pic ter-
sebut disimpan. Bentuk data dan
settingan address ini akan dibentuk
oleh mIRC pada file aaddddrrbbkk..iinnii. Jadi
bagi pengguna warnet yang ingin
tetap membawa ke rumah maupun
ke warnet bawa saja file tersebut.

Info
Opsi ini memberikan keterangan ke-
pada kita tentang orang yang kita
hubungi tersebut. Caranya, dari nick
list mIRC, kita klik kanan pada nick
(yang akan dimasukkan ke address
book) lalu pilih “Info.”

Atau anda dapat langsung mengetik-
kannya di Message Bar.

Sintaknya adalah: //uuwwhhoo  [[nniicckk]].
Misal, /uwho kos2002.

Dengan catatan, perintah ini berjalan
jika orang yang di info (uwho)
sedang online.

Maka hasilnya akan seperti gambar
berikut.

Notify
Pada bagian address book, salah satu
opsi yang manarik lainnya adalah
NNoottiiffyy. Pada bagian ini adalah favorit
penulis. Fungsi notify ini adalah
memberitahukan kita, bahwa nick
(yang masuk kedalam list/daftar)
tersebut sedang online atau tidak.

AddrAddress Book mIess Book mIRRCC
CarCara Memanfaatkana Memanfaatkan

Address Book pada program chat mIRC sebenarnya mempunyai banyak fungsi yang dapat dimanfaatkan
oleh para “tukang ngobrol.” Jika anda sering menggunakan mIRC, ikuti uraian Freddy Hernawan

(Pedhet_008@yahoo.com) berikut ini yang membahas kegunaan fasilitas yang satu ini.

S
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Misalnya saja Nickserv. Jika Nickserv
kita masukkan ke dalam notify list
ini, maka kita akan tahu server seka-
rang sedang down atau tidak. Jika
Nickserv tercantum di dalam daftar
notify, maka server tidak down, jika
sebaliknya, maka dapat disimpulkan
server sedang down.

Jika ada teman kita misalnya si_ayu,
kita masukkan ke dalam notify list,
ketika dia terkonek dengan server
chat, maka dengan otomatis notify
list akan memasukkan nick-nya ke
dalam notify list (sedang OL), dan
memberitahukan kita bahwa si ayu
sedang Online. Dengan demikian kita
dapat mengagetkan atau memberi
surprise teman kita itu, dengan
menyapanya dahulu, sebelum dia
masuk ke channel.

Jika kita ingin memasukkan sebuah
nick kedalam daftar notify lewat
message bar, sintaksnya adalah
//nnoottiiffyy  [[nniicckk]]  [[kkeetteerraannggaann]]. Sebagai
contoh misalnya kita ingin mema-
sukkan nick “Samurai_hacker” ke
dalam notify list caranya di message
bar ketikkan //nnoottiiffyy  SSaammuurraaii__hhaacckkeerr
tteemmaann  bbaaiikkkkuu. Untuk keterangannya,
boleh ditulis dan boleh juga tidak,
jadi boleh langsung ditulis //nnoottiiffyy
SSaammuurraaii__hhaacckkeerr..  

Dengan demikian jika samurai hacker
ada online maka akan masuk/tampil
di dalam daftar notify (popup notify).
Sehingga jangan kaget jika ada teman
anda yang dapat langsung nyelonong
menyapa anda ketika anda baru saja
terkoneksi ke server, padahal anda
belum masuk ke satu channel pun.

Gambar di atas adalah gambar popup
notify list. Popup ini akan muncul
otomatis jika pada notify address
book diaktifkan. Namun jika ingin
memunculkannya secara manual,
anda cukup mengklik icon notify list
pada button list (di bawah toolbar).

Control
Di dalam Control ini terdapat empat
macam opsi, yaitu Ignore, OP, Voice
dan Protect.

• Ignore di sini artinya kita tidak akan
dapat menerima pesan apa pun (teks
di channel, invite, dcc dll) dari orang
yang kita masukkan daftar Ignore.

• OP, yaitu
kita 'meng-
angkat'
Operator
secara
otomatis yang
terdapat
didalam
daftar
tersebut.

• Voice, sama halnya dengan opsi OP
tersebut di atas, kita memberikan
voice (+v) kepada orang yang masuk
ke dalam list. Hal ini bisa juga
disebut sebagai autovoice.

• Protect, yaitu kita memberikan per-
lindungan kepada orang lain, berupa
Unban, jika orang yang kita protect
di ban dan lain sebagainya.

Ketiga opsi terakhir (OP, Voice dan
Protect) hanya berlaku jika kita ada-
lah Operator channel  bersangkutan.
Namun opsi Ignore dapat diberlaku-
kan oleh semua user. Opsi Ignore ini
biasanya digunakan pada inviter-
inviter yang nakal, flooder, dan hal-
hal lain yang tidak semestinya. Dengan
demikian, chat kita menjadi lebih ber-
sih dan tenang. Setting Control akan
tercatat oleh program mIRC dengan
nama file control.ini di folder pro-
gram mIRC berada. Jadi kita juga
dapat mengeditnya dari sana.

Nick
Berikut adalah beberapa fungsi yang
dapat anda jumpai pada Nick di
Address Book mIRC.

• Add berfungsi menambahkan daftar
nick yang akan dimasukkan.

• Edit untuk mengubah setting pada
sebuah nick.

• Delete untuk menghapus nick dari
dalam daftar.

• Up dan Down untuk mengurutkan
daftar nick sesuai dengan keinginan
kita. Hal tersebut juga akan berpe-
ngaruh pada “nick mana” yang
lebih dulu diproses.
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FFasilitasasilitas BaruBaru && ‘W‘Wajah Baru’ajah Baru’
SeputarSeputar mImIRRCC

Membajak software lebih digandrungi dibandingkan membuat software sendiri. Mengubah-ubah
software yang sudah ada agar berfungsi atau berpenampilan sesuai dengan yang kita kehendaki

adalah suatu pembajakan jenis lain. Putut Indrayana (matrik7@yahoo.com) membahas
Resource Hacker hanya untuk keperluan pendidikan dan pemakaian sendiri.

Link ke mIRC
NDA DAPAT MEMBUAT LINK DI
Web anda agar pengunjung
Web dapat tersambung ke
mIRC dan chat dengan anda

di channel yang anda kehendaki. Cara-
nya dengan membuat link di Web
dengan format: irc://irc.server.net:port/
channel. Maka program mIRC 6.0 akan
dipanggil dan anda akan tersambung
ke irc.server.net .

Namun bila anda telah menjalankan
program mIRC maka akan muncul pop-
up dialog yang  akan meminta konfir-
masi anda untuk mengganti koneksi
yang ada, bergabung dengan channel
dengan koneksi saat ini atau membuat
koneksi baru.

Link pada Web untuk chatting dengan
mIRC 6.0 adalah:
<AHREF=”irc://irc.dal.net:6667/neoteker?”>Chati
ng di #neoteker </A>

Link di atas hanya bekerja di MS
Internet Explorer

Fasilitas Multi Server 
mIRC versi 6.0 ke atas telah memiliki
fasilitas ini, sehingga kita cukup men-
jalankan satu program mIRC untuk
tersambung ke berbagai server seperti
dal.net, effnet, undernet dan lain seba-
gainya. Caranya:

1. Dengan memilih fasilitas New Ser-
ver Window pada mIRC Option
lalu Connect. Maka anda akan ter-
sambung ke server berikutnya.

2. Dengan mengetikkan “/server -m
<server baru> “ pada window
mIRC 
Contoh: /server -m liberty.dal.net 7000

Membuat Kotak Dialog di mIRC
Kotak dialolg (dialog box) adalah pop-
up dengan tampilan GUI. Untuk mem-
buat kotak dialog box di mIRC, kita
harus menuliskan skripnya di bagian
Remote (Alt+R).

1. Menulis skrip mIRC di bagian
Remote

dialog first { 
title “Ini adalah kotak dialog pertamaku” 
size -1 -1 300 100 

;Size di sini membuat popup berada di
;tengah (-1 -1) layar. Lebar 300 dan 
;tinggi 100.

button “OK”,1, 1 75 120 25, OK 

;Tombol sangat diperlukan. Tombol ini
;memiliki id 1. dan berada 1 dari kiri dan
;75 ke bawah dari atas kiri dialog.
;Lebar 120, tinggi 25.

text “Hello World”,2, 1 1 100 25 
}

;lalu untuk menjalankannya ketik  
;”/dialog -m pertama”  di window mIRC

hasilnya:

Format untuk tombol adalah:
button “text”,id, x y w h,style (style dapat
serupa, ok, atau cancel). 

Format untuk teks:
text "text",id,x y w h, style

2. Membuat editbox
Format edit box: edit “text”,id,x y w h

dialog editbox { 
title “Edit box pertama”
size -1 -1 300 100 
button “OK”,1, 1 75 120 25, OK 
edit “Text anda”,2, 10 30 150 20 

} 

hasilnya:

3. Membuat check box

Format check box: check “text”,id, x y w
h,style

dialog checkbox { 
title “Membuat Chack box”
size -1 -1 300 100 

Fasilitas Baru mIRC 6.x

A
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button "OK",1, 1 75 120 25, OK 
check "Contoh Checkbox",2, 5 30 170 25,3
state 

} 

hasilnya:

4. Membuat frame box

Formatnya: box "title text",id, x y w h,style

dialog frame { 
title “Frame Box”
size -1 -1 300 100 
button “OK”,1, 1 75 120 25, OK 
box “Script Info”,2, 20 5 110 60 
text “Contoh Frame box”,3, 25 20 60 25 
text “Pertama”,4, 25 45 60 45 

}

hasilnya:

5. Membuat Tab

Format tab: tab “Tab Title”,id,x y w h

Menu menubar { 
&Tab Dialog:/dialog -m tab tab
}
dialog tab {

title “Contoh Tab dialog”
size -1 -1 212 100
option dbu

tab “Multi sever”,1, 5 5 150 95
tab “Join Chanel”,2
tab “Penulis”,3

button “Done”,6,160 85 50 20,ok

check “Multi serv”,7, 20 25 80 20, tab 1
check “Automatic Join Chanel”,8, 20 25 80
20, tab 2

box “Created by Prayana”,11,20 25 115
4,tab 3
text “Dedicated to Santie Novera”,12,20 50
100 20,tab 3
text

“email:prayana1@yahoo.com”,13,20 60 100
20,tab 3
text “#neoteker Learning Center”,14,20 70
100 20,tab 3
text “irc://irc.dal.net:6667/neoteker?”,15,20
80 100 20,tab 3

box “”,17, 20 40 115 4,tab 1
text “Server”,18,20 50 27 20,tab 1
check “Dalnet”,23,20 60 60 10,tab 1
check “Undernet”,24,20 70 60 10,tab 1
check “Efnet”,25,20 80 60 10,tab 1

box “”,26, 20 40 115 4,tab 2
check “#Neoteker”,32,20 60 60 10,tab 2
check “#Indonesiana”,33,20 70 60 10,tab 2
check “#comp”,34,20 80 60 10,tab 2

}

hasilnya:

Resource Hacker untuk Mengubah ‘Wajah’ mIRC
ERNAHKAH ANDA MELIHAT SOFTWARE YANG sudah tidak
asli lagi? NeoTek pernah membahas mengganti
tulisan Start pada Windows menjadi Cakra (April

2002). Untuk itu digunakan cara manual masuk langsung
ke kode heksadesimal software menggunakan Hiew.

Tapi bagaimana bila ingin mengubah tampilan suatu soft-
ware secara keseluruhan? Gunakan Resource Hacker, suatu
software untuk reverse engineering yang berfungsi untuk

mengedit file executable yang berekstensi .exe dan .dll

1. Download Resource Hacker dari
http://www.users.on.net/johnson/resourcehacker/ atau
dari http://www.momol.net/berkas/reshack.zip

2. Ekstrak zip filenya ke folder yang kita kehendaki.

Sebagai bahan percobaan kita akan mengubah  mIRC.exe
menjadi berbahasa indonesia.

Kali ini kita harus mengeditnya
secara manual. Buka folder
menu dan pilih sub-folder yang
akan diganti.

Ganti tulisan yang bertanda ku-
tip. Yang lain sebaiknya jangan di-
ganti, karena kemungkinan dapat
menyebabkan sofware crash.

Setelah itu, klik “Compile
Script” dan lihat hasilnya.1 2 3

Mengubah Menu

P
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Buka file mIRC.exe, melalui  File
→ Open. Browse mIRC filenya ,
lalu klik Open

Pada Menu Bar, Action → Replace
Icon.

Pilih ikon dengan mengklik tombol
“Open file with new icon.”

Setelah itu, klik Replace. Maka
selesailah kita mengganti ikon
mIRC.

Pilih ikon yang kita kehendaki,
lalu klik Open.

1

2

3

4

5

Mengganti Ikon mIRC

Buka folder Bitmap, lalu pilih sub-
foldernya dan bitmap yang akan
diganti

Klik kanan di bitmap yang akan
diganti, lalu pilih “Replace
Resource.”

Klik “Open file with new bitmap.”

Setelah itu, klik Replace. Maka
selesailah kita mengganti ikon
mIRC.

Pilih file bitmap yang kita
kehendaki, lalu klik Open 

1

2

3

4

5

Mengganti File Bitmap

Buka folder dialog dan pilih dialog
yang akan diedit

Akan tampil kotak dialognya, lalu
klick kanan bagian yang akan kita
edit, dan klik Edit Control.

Klik “Compile Script” dan lihat
hasilnya.

Edit pada bagian “cartion” lalu klik
OK.

1

2

3

4

Mengubah Dialog
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UNGSI SECARA RINGKAS DAPAT DIARTIKAN SEBAGAI
suatu kumpulan/bundel dari satu atau lebih
statement-statement yang akan dieksekusi secara

bersamaan begitu nama fungsi dipanggil. Fungsi secara
garis besar dapat kita bedakan menjadi dua macam yaitu:

• Fungsi buatan sendiri
Fungsi yang didefinisikan/deklarasikan sendiri untuk
memenuhi kebutuhan. Cara pendeklarasian dan contohnya
akan kita bahas pada bagian berikut.

• Fungsi bawaan (built-in)
Fungsi yang sudah terdefinisi dari sebelumnya, dan telah
siap pakai tanpa perlu dideklarasikan terlebih dahulu.

Beberapa contoh fungsi built-in ini adalah fungsi eval(),
parseInt(), parseFloat(), escape(), unescape(), isNaN()
dan seterusnya.

Pendeklarasian Fungsi
Sebelum dapat digunakan dalam badan program, suatu
fungsi harus dideklarasikan terlebih dahulu, jika fungsi
itu buatan sendiri. Bagian deklarasi ini merupakan bagian
yang paling penting karena merupakan pendefinisian dari
fungsi itu sendiri. Apa yang harus dilakukan oleh fungsi
akan terdefinisi pada bagian deklarasi ini.

Secara umum pendefinisian suatu fungsi yaitu dengan
menggunakan kata kunci fungsi yang langsung diikuti
dengan nama fungsi yang akan kita deklarasikan. Perhati-
kan sintaksnya berikut ini:

Perhatikan bahwa pendeklarasian di atas fungsi tidak me-
miliki argumen-argumen masukan (input). Jika terdapat
argumen masukan bagi fungsi yang sedang dideklarasi-
kan maka argumen masukan bagi fungsi tersebut diletak-

kan di dalam tanda kurung setelah nama fungsi dengan
pemisah tanda koma. Perhatikan contoh sintaks berikut:

Catatan:

• Argumen atau parameter merupakan nama-nama dari
variabel yang akan digunakan dalam fungsi

• Penamaan fungsi hampir sama dengan penamaan
variabel, dan tidak boleh merupakan nama fungsi
bawaan (built-in)

Tips:

Tempatkan pendeklarasian suatu fungsi pada bagian awal
suatu dokumen HTML, misalnya pada bagian tag <head>,
sehingga ketika fungsi tersebut akan dipanggil kita benar-
benar yakin bahwa fungsi tersebut telah selesai di-load.

Pemanggilan Fungsi 
Suatu fungsi yang telah dideklarasikan tidak akan diekse-
kusi sampai terjadi pemanggilan terhadap fungsi tersebut.
Sebenarnya pemanggilan fungsi merupakan bagian yang
paling mudah karena kita cukup menggunakan nama
fungsi disertai nilai-nilai argumen masukan (jika ada).

Perhatikan sintaks berikut:

Atau untuk fungsi tanpa argument masukan :

Rekursi
Fungsi rekursi adalah suatu fungsi yang memanggil diri-
nya sendiri. Teknik rekursi ini banyak digunakan untuk

Fungsi pada JavaScriptFungsi pada JavaScript
Pada bagian keenam tutorial JavaScript ini dibahas apa yang dinamakan fungsi. Fungsi yang pada dasarnya
adalah kumpulan statement mempunyai manfaat khusus pada pemrograman dengan JavaScript. Dengan

fungsi, satu statement atau lebih dapat dieksekusi secara bersamaan.

Function nama_fungsi(argument1, argument2, argument3,..)

Nama_fungsi(argumen1,argumen2,argumen3,..)

Nama_fungsi()

Function nama_fungsi(){
// statemen-statemen yang akan dikerjakan
// jika fungsi dipanggil dituliskan 
// diantara kurung kurawal ini
}

F
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mempersingkat penulisan listing program sehingga lebih
efektif.

Catatan:

• Pada pemanggilan fungsi yang memililki argumen-
argumen masukan (input), banyak dan urutan argumen
harus sama persis dengan banyak dan urutan argumen
pada deklarasi dan fungsi tersebut.

Mengembalikan ke Suatu Nilai
Suatu fungsi dapat kita buat agar mengembalikan ke suatu
nilai. Perhatikan bahwa sebagian fungsi bawaan (built-in)
dalam JavaScript juga merupakan fungsi yang mengem-
balikan ke suatu nilai.

Cara untuk mengembalikan ke suatu nilai adalah dengan
menggunakan kata kunci return diikuti dengan nilai yang
akan dijadikan nilai kembalian fungsi tersebut.

Perhatikanlah contoh sederhana berikut ini:

Jika kemudian fungsi dipanggil pada bagian program:

Maka variabel nilai tersebut akan memuat nilai 20.

Fungsi dalam Contoh
Untuk lebih memantapkan pemahaman kita, berikut ini
kita akan melihat suatu contoh penggunaan fungsi. Kita
akan menggunakan fungsi untuk menampilkan kotak
peringatan (alert box) ketika suatu button pada halaman
Web ditekan.

Pada contoh ini kita akan menggunakan salah satu metode
dari objek window yaitu metode alert() yang fungsinya
untuk menampilkan alert box. Perhatikan sintaksnya di
bawah ini:

Alert("Di sini pesan yang akan ditampilkan").

Selanjutnya kita akan menempatkan event onClick pada
button yang nantinya akan ditekan. Pembahasan tentang
masalah event ini akan dibahas lebih lanjut pada tulisan
mendatang.

Mari perhatikan skrip selengkapnya pada boks dengan
judul “test fungsi alert box” pada kolom kanan bagian
atas.

Silakan simpan kode di atas dalam ekstensi HTML. Lalu
jalankan di browser anda, dan tekan button yang ada. Jika
browser anda mendukung JavaScript maka begitu button
tersebut ditekan akan muncul alert box.

Nah, di atas adalah contoh fungsi tanpa argument masukan,
lalu bagaimana dengan fungsi yang mempunyai argumen
masukan? Perhatikan contoh berikut ini. Yaitu suatu
fungsi yang digunakan untuk menghitung hasil kali dari

dua angka yang di masukkan dengan cara menampilkan
hasilnya pada alert box.

Pertama kita akan mendefinisikan fungsinya terlebih da-
hulu. Baru kemudian kita panggil dengan menggunakan
event onClick pada button. Perhatikan keterangan yang
langsung disertakan dalam listing program berikut ini:

Perhatikan bahwa pada saat fungsi dipanggil, langsung
disertakan dua argumen masukan yang merupakan nilai-
nilai dari text box satu dan dua. Cara mengaksesnya yaitu
dengan menggunakan objek window, penjelasannya ada
pada tulisan yang membahas khusus masalah Objek
Window mendatang.

Nah, ternyata bermain-main dengan fungsi Javascript
tidak terlalu sulit bukan? Selamat belajar!

Function kali(x,y) {
Hasil=x*y;
Return hasil  // kembalikan nilai fungsi kali() ke hasil kali x 

// dan y
}

<html><head>
<title>test fungsi dengan argumen masukan</title>
<script language="javascript">
<!--
function kali(angka1,angka2){

//fungsi kali memiliki 2 argumen masukkan
//yaitu angka1 dan angka2

document.formulir.tiga.value=angka1*angka2
//nilai dari text box akan
//diisi dengan hasil kali
// 2 argumen masukkan

}
//-->
</script></head>
<body>
<form name="formulir">
<input type="text" name="satu">
<input type="text" name="dua">
<input type="text" name="tiga">
<input name="tombol" type="button"
onClick="kali(document.formulir.satu.value,document.formulir.dua
.value)" value="Kalikan!">
</form></body>
</html>

Nilai= kali(4,5) // hasil kembalian fungsi kali () dimasukkan dalam

//variabel nilai 

<html><head>
<title>test fungsi alert box</title>
<script language="javascript">
<!--
function tekan(){
alert("Hai..., selamat belajar Javascript ya!!! :)")
}
//-->
</script></head>
<body><form>
<input type="button" onClick="tekan()" value="Tekan Saya
Untuk Menampilkan Pesan! :)">
</form></body>
</html>

Catatan:

JavaScript adalah suatu client-side scripting 
sehingga anda tidak perlu menginstal server 

untuk menguji skrip yang anda buat.
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anyak kesalahan dalam bekerja
dengan komputer semata-mata
disebabkan faktor human error.

Misalnya kita tanpa sengaja menghapus
file dengan menekan tombol Shift+
Delete. Artinya file tersebut akan terha-
pus dan tidak perlu mampir ke Recycle
Bin. Awalnya kita mengira file tersebut
sudah tidak terpakai lagi. Ternyata file
tersebut masih diperlukan dan tergolong
file yang penting. Bagaimana solusinya?

Kali ini Neotek menyajikan cara “mem-
bangkitkan” file yang telah “terkubur”
tersebut. File  itu ternyata masih dapat
di-undelete dengan menggunakan pro-
gram bantu. Salah satunya adalah
FileRecovery yang dibuat oleh LC
Technology dari Florida.

B

FILE KELINCI PERCOBAAN
Setelah selesai instalasi, pilih file
Carved Stone.bmp yang berada di
folder Windows sebagai file kelinci
percobaan. Kemudian copy-lah file
tersebut ke folder My Documents.
File inilah yang akan diutak-atik.

4

10 11

5 6

12

HAPUS DENGAN SHIFT+DELETE
Sorot file Carved Stone.bmp yang
telah ada di folder My Documents.
Kemudian tekan tombol Shift dan
Delete sehingga kedua file tersebut
terhapus tanpa perlu dipindah ke
Recycle Bin.

JALANKAN FILERECOVERY
Jalankan program FileRecovery
dengan mengklik ganda file
Recover.exe. Tampilan splash
screen-nya akan hadir selama bebe-
rapa detik sebelum berganti dengan
jendela utama FileRecovery.

SCANNING DIMULAI
Biarkan opsi-opsi yang lain dan se-
lanjutnya anda hanya perlu mene-
kan tombol OK untuk memulai
proses scanning. 

SCANNING SELESAI
Proses scanning akan berlangsung
beberapa waktu tergantung pilihan
setting sebelumnya. Proses scan-
ning ini berakhir dengan hadirnya
kotak dialog “End of deleted file
scan.”

RESURRECTI0N
Tekan saja tombol OK untuk menu-
tup kotak dialog itu. Untuk “mem-
bangkitkan” file yang terhapus tadi,
sorotlah file Carved Stone.bmp

Filerecovery dapat menyelamatkan anda dari “bencana.”

“M“MEEMMBBANANGGKKIITTKKAN”AN”
FFIILE TLE TEERRHAPHAPUUS DS DEENNGGANAN
FFIILELERREECOCOVVEERRYY
File terhapus tidak sengaja? Tidak perlu putus asa. Happy
Chandraleka (Cakrabirawa@mail.ru) punya jalan keluarnya.
Gunakan FileRecovery for Windows dan file anda pun dapat
“dibangkitkan” kembali dengan relatif mudah. Silakan simak caranya.
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7 8 9
DRIVE OPEN
Klik tombol yang bergambar hard
disk atau dengan memilih menu
File → Drive Open, sehingga tampil
jendela baru untuk memilih drive
yang akan di-scan.

MEMILIH DRIVE UNTUK DI-SCAN
Pada kotak Select the drive for
scanning, tentukan drive yang
akan di-scan untuk mencari file-file
yang terhapus. Dalam hal ini pilih-
lah drive C:\ , karena folder My
Documents berada di C:\ .

MENENTUKAN SCANNING OPTIONS
Pada bagian Specify scanning
options, pilih Search the speci-
fied existing directory. Kemudian
tekan tombol Browse dan sorot
folder My Documents. Akhiri
dengan menekan tombol OK.

1 2 3
EKSTRAKSI RECOVER.EXE
FRC-demo.zip memuat empat file:
Recover.exe (aplikasi); FileRecovery.chm
(help); license.txt; dan readme1st.txt.
Ekstrak dengan Winzip dan tentukan
folder tempat hasil ekstraksi. Klik ganda
Recover.exe untuk menjalankan pro-
gram FileRecovery ini. Tampilan splash
screen-nya tampak di atas.

13 14 15
KOTAK DIALOG SAVE
Kemudian pilih menu File →
Undelete sehingga tampil kotak
dialog Save. Tekan tombol Browse
untuk menentukan tempat menyim-
pan file yang akan “dibangkitkan.”

BROWSE KE FOLDER
Pada bagian ini tentukan folder/
drive yang berbeda dengan tempat
file yang akan “dibangkitkan.”
Pilihlah drive selain C:\ , misalnya
drive D:\ . Anda dapat juga memilih
drive A:\ untuk tempat baru bagi
file yang akan “dibangkitkan.”

UNDELETE DONE
Tutup kotak dialog “Browse for
Folder” tersebut dengan menekan
tombol OK. Lanjutkan lagi dengan
menekan tombol OK dari kotak
dialog Save. Proses pembangkitan
selesai dengan hadirnya kotak
dialog “Undelete done.”

BERTANDANG KE LC TECHNOLOGY
Pada browser ketik www.lc-tech.com
dan masuk ke LC Technology, Inc.
Pada kolom Software klik FILERE-
COVERY for Windows. Anda
akan memasuki halaman FILERECO-
VERY for Windows. Klik Download
untuk men-download program ini.

ISI FORM SEBELUM DOWNLOAD
Tampil form isian. Pada bagian Which
products are you downloading, pi-
lih salah satu produk yaitu FILERECO-
VERY for Windows. Lengkapi isian ber-
ikutnya dan klik tombol Submit. Masuk
ke download page. Klik Download
the demo.
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ada bahasan “membangkitkan”
file dengan FileRecovery, anda
telah mengetahui bahwa suatu

file yang telah dihapus ternyata dapat
dimunculkan kembali. Ada satu masalah
yang timbul berkaitan dengan keamanan
data, bagaimana menghapus file yang
tergolong rahasia sehingga tidak dapat
dikembalikan seperti awalnya agar tidak
ada orang lain yang mengetahui isinya?

Solusinya adalah dengan File Shredder
2000. Program ini dapat menghapus file
sehingga tidak dapat dikembalikan. Akan
dipaparkan bagaimana dua program
(yaitu FileRecovery dan File Shredder
2000) bekerja. File Shredder 2000 akan
menghapus file sehingga tidak bisa
“dibangkitkan” secara sempurna.

P

FILE KELINCI PERCOBAAN
Masuklah ke folder tempat anda
mengekstrak paket FRC-demo.zip
pada pembahasan terdahulu. Sorot
file License.txt dan copy-kan ke
folder My Documents.

4

10 11

5 6

12

JALANKAN FILE LICENSE.TXT
Jalankan file License.txt pada folder
My Documents. Perhatikan isinya.
Anda nanti perlu membandingkan
dengan file hasil “pembangkitan”
yang telah dihapus dengan File
Shredder 2000.

MENGHAPUS DENGAN FILE
SHREDDER
Jalankan program File Shredder
2000. Sorot file License.txt pada
folder My Documents dan lakukan
“drag and drop” file tersebut hingga
masuk ke daftar File Shredder
2000.

MENENTUKAN DRIVE YANG DI-
SCAN
Klik menu File → Drive Open. Pada
kotak Select the drive for scanning
pilih drive C:\, dan pada kotak
Specify scanning options pilih
Search the specified existing
directory.

MENENTUKAN FOLDER YANG DI-
SCAN
Lanjutkan dengan menekan tombol
Browse sehingga tampil kotak
dialog Browse for Folder. Cari
dan sorotlah folder C:\My Documents.
Akhiri dengan menekan tombol OK.

PROSES SCANNING DIMULAI
Setelah Anda menekan tombol OK,
pada kotak dialog Select drive to
be scanned, proses scanning akan
dimulai. Proses berakhir dengan
tampilnya kotak dialog End of
deleted file scan.

File Shredder dapat menyelamatkan anda dari “bencana.”

MMEENNGGHAPHAPUUS FS FIILELE
DDEENNGGANAN
FFIILE SLE SHHRREEDDDDEERR
Tidak ingin file yang anda hapus “dibangkitkan” orang lain? Sebagai
kebalikan dari FileRecovery, Happy Chandraleka (Cakrabirawa
@mail.ru) mengajak anda menghapus agar tidak ada seorang pun
yang dapat mengembalikannya secara sempurna.
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7 8 9
MENU SEND TO
Anda dapat juga menggunakan klik
kanan mouse pada file License.txt
sehingga tampil menu pop up.
Kemudian pilih menu Send to dan
menu File Shredder.

KONFIRMASI DAN PERINGATAN
Setelah menu File Shredder dipilih,
akan tampil kotak dialog konfirmasi
dan juga peringatan bahwa file
tersebut nantinya tidak dapat
“dibangkitkan” secara sempurna.
Tekan saja tombol Yes untuk
melanjutkan proses

JALANKAN FILERECOVERY
Kini saatnya mencoba
“membangkitkan” file yang telah
dihapus tersebut. Klik ganda file
Recover.exe untuk menjalankan
program FileRecovery yang telah
Anda instal pada pembahasan
terdahulu.

1 2 3
EKSTRAKSI & INSTALASI
Setelah mengesktrak dan meng-
unzip file itu, lanjutkan dengan pro-
ses instalasi. Setelah instalasi, anda
dapat melakukan beberapa penga-
turan lewat tab Options pada
program File Shredder 2000.

13 14 15
PERCOBAAN RECOVERY
Setelah proses scanning selesai,
sorot file License.txt dan tekan
tombol Undelete. Pada kotak dia-
log Save yang tampil tekan tombol
Browse. Pilih drive selain C:\ ,
misalnya D:\ . Proses berakhir
dengan tampilnya kotak pesan
Undelete done.

BERPINDAH KE DRIVE D:\
Tekan tombol OK untuk menutup
kotak pesan tersebut. Kemudian
buka Explorer dan beralihlah ke
drive D:\ dan cari file License.txt
hasil “pembangkitan” pada langkah
sebelumnya.

“PEMBANGKITAN” GAGAL BUNG!
Klik ganda pada file License.txt
tersebut. Yang menarik, isi file
tersebut bukanlah isi file License.txt
sebelum “dibangkitkan.” File
Shredder telah “mencabiknya”
sehingga proses recovery tidak
sempurna.

DOLAN KE SOFTWARE DESIGN
Masuk ke www.gregorybraun.com.
Pada halaman utama situs, scroll ke
bawah. Klik File Shredder 2000 v3.3.
Anda dibawa ke halaman File Shredder
2000. Scroll ke bawah, klik link SHRED-
DER.ZIP untuk mendownload pro-
gram yang berukuran sekitar 104 Kb.

DOWNLOAD FILE SHREDDER
Tampil kotak dialog konfirmasi dengan
empat tombol. Klik Save untuk men-
download file Shredder.zip. Proses
downloading dimulai. Bila telah sele-
sai, klik ganda file Shredder.zip.
Dalam paket tersebut hanya terdapat
satu file yaitu Shredder_Setup.exe.
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ada Neotek Vol II No. 9, Juni
2002, Happy Chandraleka telah
menguraikan cara menjaga fol-

der anda dengan menggunakan utilitas
Folder Guard, Modifikasi Registry, dan
lewat Dos Prompt. Selain ketiga cara
tersebut, ada cara pengamanan folder
yang lain yaitu dengan pemberian pass-
word pada folder seperti yang akan
diuraikan berikut ini.

Untuk itu anda membutuhkan skrip
(lihat skrip pada Langkah 7) untuk
menjalankan fungsi atau merespon agar
anda memasukkan password jika ingin
mengkases atau melihat file-file di folder
pribadi anda.

P

PILIHAN “CREATE OR EDIT AN
HTML DOCUMENT”
Pada kotak dialog “Customize this
Folder,” lihat apakah radio button
di depan pilihan “Create or edit an
HTML document” telah terpilih. Jika
ya, klik tombol Next di bagian
bawah kotak dialog itu.

4 5 6
MELANJUTKAN PENGATURAN
Masih di menu “Customize this
folder,” setelah anda mengklik Next,
kembali klik tombol Next pada kotak
dialog yang berikutnya yang muncul.

TEKS FOLDER ANDA
Selanjutnya akan terbuka editor teks
Notepad yang berisi teks dari folder
yang akan anda lindungi dengan
password.

1 2 3
MENGATUR FOLDER
Lanjutkan langkah anda dengan
menekan tombol View pada
Windows Explorer, dilanjutkan
dengan memilih “Customize this
Folder.”

Memberi password agar folder anda aman.

JJAAVVAASSCCRRIIPTPT
MMEENNGGAMANAMANKKAN FAN FOOLDLDEERR
DDEENNGGAN PAN PAASSSWSWOORRDD
Ada banyak cara untuk mengamankan data. Melindungi folder
adalah salah satunya. Upaya proteksi folder kali ini adalah dengan
memberikan password. Odyxb (odyxb@chat-plus.org) menjelaskan
caranya langkah demi langkah.

BUKA WINDOWS EXPLORER
Buka Windows Explorer dengan
menekan tombol Start → Program
→ Windows Explorer.

MEMBUKA FOLDER
Setelah Windows Explorer terbuka,
arahkan mouse pointer ke salah
satu folder anda untuk melihat file-
file di dalamnya. 
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8

7
MENEMUKAN SCRIPT LANGUAGE
Seperti dijelaskan di atas, agar
Windows merespons anda dengan
permintaan memasukkan password,
anda harus menyisipkan skrip di
bawah ini. Untuk itu, scroll turun
Notepad anda sampai pada tulisan
<script language=”JavaScript”>.

Skrip untuk meminta password:

9 10
MENYELESAIKAN PENGATURAN
FOLDER
Kembali ke menu “Customize this
Folder,” klik Finish untuk meng-
akhiri kerja kita dalam pengamanan
folder dengan password.

MENTES HASIL KERJA
Untuk menguji hasil kerja anda di
atas, cobalah klik folder yang telah
anda customize tersebut. Jika
berhasil, anda akan diminta
memasukkan password untuk
dapat melihat file-file di dalam
folder tersebut.

MENYISIPKAN SKRIP PASSWORD
Kini sisipkan skrip seperti pada
Langkah 7 di bawah <script
language=”JavaScript”>
Jangan lupa mengganti tulisan
“Your Password Enter Here” dengan
password pilihan anda. Setelah itu
simpan (save) data tersebut dengan
memilih menu File → Save
Selanjutnya silakan tutup Notepad
anda.

var pass = prompt("Enter Your Code 
Access or Get out")
if(pass !="Your Password Enter Here")
{window.location="C:"}

ACI
OOddyyxxbb berdomisili di Medan dan me-
rupakan pendiri ACI (Asosiasi Cende-
kiawan Indonesia). Pada situsnya,
organisasi ini dikatakan bertujuan:
“membina cendekia profesional yang
memiliki IPTEK (Ilmu Pengetahuan
dan Teknologi) dan IMTAK (Iman dan
Takwa) serta turut menyukseskan
pembangunan nasional demi
terwujudnya masyarakat madani
yang diridhai Allah SWT.” Untuk
melaksanakan tujuannya, ACI
menggalang beberapa program. ACI
menerima keanggotaan setiap warga
negara Indonesia yang telah berusia
17 tahun.

Alamat situs ACI: www.a-c-i.i-p.com
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AGI PEMAKAI INTERNET TENTUNYA MENGIRIM ATAU
menerima email sudah merupakan suatu kebutuh-
an, karena dengan biaya murah dapat berkomuni-

kasi dengan teman-teman di penjuru dunia.

Aktivitas untuk mengirim dan menerima email ini dila-
kukan dengan berbagai cara dan sarana. Secara umum,
biasanya orang menggunakan:
• WebMail atau disebut juga HTTPMail
• POP3 untuk menerima email
• SMTP untuk mengirim email serta yang lainnya adalah

IMAP4.

Tapi, tahukah anda bagaimana komunikasi yang terjadi
antara mail client dengan mail server? Untuk menjawab
pertanyaan ini kami membuat “mail server tiruan.”

Mengapa Mail Server Tiruan?
Fungsi mail server yang dibuat ini adalah untuk merekam
komunikasi antara mail client dengan mail server (dalam
hal ini SMTP Server dan POP3 Server). Server tiruan ini
merupakan sarana yang baik bagi anda untuk mempela-
jari socket programming, serta memahami cara kerja SMTP
Server dan POP3 Server.

Selain itu, anda dapat memanfaatkan server tiruan ini un-
tuk keperluan lain. Misalkan anda sedang membuat apli-
kasi mail client, maka anda dapat mensimulasikan aplikasi
anda pada mail server tiruan ini. Jika ada kesalahan, anda
dapat menganalisa file LOG yang dihasilkan.

SMTP Server
SMTP (Simple Mail Transfer Protocol) Server merupakan
salah satu aplikasi protokol TCP yang menggunakan port 25.

SMTP Server merupakan salah satu aplikasi Internet yang
cukup tua, karena SMTP didefinisikan pertama kali pada
tahun 1971 (RFC821) dan update terakhir dibuat pada
tahun 2001 (RFC2821).

Cara kerja server ini cukup kompleks. Pertama-tama pe-
ngirim (sender) mengirimkan mail object ke SMTP Server
pengirim. Lalu, mail object ini akan diteruskan ke SMTP
Server penerima (receiver) oleh SMTP Server pengirim,
jika SMTP Server penerima tidak sama dengan SMTP
Server pengirim. Oleh karena itu, ada yang mengatakan
bahwa SMTP Server itu bersifat “store and forward.”

POP3 Server
POP3 (Post Office Protocol versi 3) Server adalah salah
satu aplikasi protokol TCP yang menggunakan port 110.

POP versi 1 didefinisikan pertama kali pada tahun 1984
(RFC918). Sedangkan POP versi 3 didefinisikan pertama
kali pada tahun 1988 (RFC1081) dan diperbaharui pada
tahun 1996 (RFC1939).

Dibandingkan SMTP Server, tugas POP3 Server lebih
ringan. Tugasnya adalah melihat apakah ada mail object
untuk pengguna. Jika YA, maka mail object tersebut akan
di-download dan kemudian dihapus.

MailMail ServServerer TiruanTiruan
Untuk mempelajari socket programming serta memahami cara kerja SMTP server serta POP3

server, Fitrianto Halim (fitriantoh@hotmail.com) membuat mail server tiruan dengan
menggunakan Java. Manfaatkan untuk mensimulasi aplikasi anda dengan analisa file log-nya.

Menggunakan Java untuk MembuatMenggunakan Java untuk Membuat

B

• Instal Java 2 SDK 1.4.0 untuk dapat menjalankan Java di mesin anda.
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Program
Karena aplikasi ini merupakan mail server tiruan, maka
reply-nya umumnya baik (tidak ada error yang dihasilkan).

Untuk SMTP Logger, anda dapat melihat source-code-nya
pada file SMTPLog.java, sedangkan untuk POP3 Logger,
Anda dapat melihat source-code-nya pada file POP3Log.java.

Untuk mengkompilasinya ke byte-code, ketikkan perintah
berikut pada DOS Prompt:

• Untuk SMTP Logger
javac SMTPLog.java

• Untuk POP3 Logger
javac POP3Log.java

Proses kompilasi dengan Java compiler (javac.exe) ini akan
menghasilkan dua Java applet masing-masing dengan nama
SMTPLog.class dan POP3Log.class yang akan kita jalankan
sebagai mail server tiruan.

Pengujian
Pertama-tama, periksa berapa IP Address komputer anda.
Misalkan IP (periksa dengan menjalankan winipcfg). Mi-
salkan didapat bahwa IP Address anda 203.125.32.178 (se-
dang terhubung secara dial-up ke ISP). Atau bila dalam LAN
(offline), IP Anda misalnya 192.0.0.1, maka buat file teks
dengan nama HOSTS (tanpa ekstensi .TXT) yang isinya:

192.0.0.1       mail.neotek.co.id
192.0.0.1       smtp.neotek.co.id
192.0.0.1       pop3.neotek.co.id

bila IP address komputer anda 203.125.32.178

192.0.0.1       mail.neotek.co.id
192.0.0.1       smtp.neotek.co.id
192.0.0.1       pop3.neotek.co.id

bila IP address komputer 192.0.0.1, yaitu IP address dari
ethernet card milik penulis. Tujuannya adalah untuk mem-

6 COPY HOSTS KE C:\WINDOWS
Copy file HOSTS ke folder Windows
di C:\Windows. Perhatikan bahwa
file ini harus bernama HOSTS (bukan
HOSTS.TXT). Hati-hati dengan text
processor yang secara otomatis
memberi ekstensi .txt, sebab file
tersebut tidak akan dikenali.

PERIKSA IP ADDRESS
Periksa IP address komputer anda
dengan menjalankan winipcfg dan
catat IP address yang didapat dari
ISP sewaktu komputer terhubung
ke Internet. Apabila komputer
anda terhubung ke LAN, mungkin
IP address-nya telah ditetapkan
secara lokal. Misal: 192.0.0.1

BUAT FILE HOSTS
Dengan Notepad buat file dengan
nama HOSTS yang isinya merupa-
kan daftar IP address dan nama
aliasnya. Anda buat sendiri yang
sesuai dengan IP address anda.
Gambar di atas hanya contoh untuk
komputer pada LAN dan terhubung
ke ISP.

4 5

3 APPLET TERBENTUK
Akan terbentuk SMTPLog.class dari
SMTPLog.java dan POP3Log.class
dari POP3Log.java.

SOURCE CODE
Letakkan kedua source code mail
serve ini (SMTPLog.java dan
POP3Log.java) dalam direktori
yang sama dengan Java 2 SDK,
yaitu di C:\j2sdk1.4.0\bin. Kedua
source code ini dapat diperoleh
dalam CD NeoTek bulan ini.

KOMPILASI MENJADI APPLET
Kompilasi kedua source code ini de-
ngan java compiler (javac.exe) lewat
DOS prompt dengan command:
javac SMTPLog.java dan
javac POP3Log.java

1 2

Kompilasi Source Code dan Penentuan Alias
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buat alias dari IP address tersebut,
sehingga mempermudah anda da-
lam men-setting mail client.

Jika anda menggunakan Outlook Ex-
press 5.0, maka setting untuk mail
server ditunjukkan pada kedua gam-
bar di sebelah kanan. Tab Advanced
sebaiknya dikosongkan, karena mail
server tiruan hanya melayani com-
mand yang sifatnya standar.

Anda kini telah selesai men-setup
Outlook Express, suatu email client
yang komunikasinya dengan mail
server tiruan kita, yang bernama
SMTPLog.class dan POP3Log.class
akan dimonitor dan direkam dalam
file log yang masing-masing ber-
nama smtp.log dan pop3.log.

6 ACCOUNT TERBENTUK
Akan terbentuk suatu Internet Account
dengan nama pop3.neotek.co.id
sebagai default mail account.
Double click untuk menampilkan
Network Properties. Pilih tab General
dan ubah namanya menjadi
NeoTek.

MAIL SERVER SESUAI ALIAS
Pada kolom Incoming mail ketik-
kan pop3.neotek.co.id sedangkan
pada Outgoing mail ketikkan
smtp.neotek.co.id. Keduanya sesuai
dengan nama alias yang ditetap-
kan pada file HOSTS yang kita
buat sebelumnya.

ACCOUNT NAME/PASSWORD
Anda dapat ketikkan account name
dan password apa saja. Pada mail
server tiruan kita ini, account name
maupun password tidak akan
diperiksa. Klik Next untuk
melanjutkan.

4 5

3 E-MAIL SEMBARANG
Sewakt ditanyakan email, anda
dapat memasukkan sembarang
email (tidak harus email yang
valid). Dalam hal ini misalnya
kosasih@neotek.co.id. Klik Next
untuk melanjutkan.

SETUP OUTLOOK EXPRESS
Setup Oulook Express dengan
memilih menu Tools > Accounts
yang akan menampilkan kotak
dialog Internet Accounts. Pada tab
Mail pilih opsi Add.

INTERNET CONNECTION WIZARD
Pembentukan Account pada
Outlook Express akan melalui
Internet Connection Wizard. Anda
mulai dengan memasukkan
nama anda. Klik Next untuk
melanjutkan.

1 2

Setup Account di Outlook Express



NeoTekno

Oktober 2002 NeoTek 33

Pertama-tama kita jalankan SMTP
Logger dengan mengetikkan perintah
berikut pada DOS prompt:
java SMTPLog

dan tampak SMTPLog berjaan
dengan tampilnya pesan:

waiting for incoming connection request...

Dengan Outlook Express kirim sebuah
e-mail dan hasilnya terekam pada file
SMTP.LOG yang dapat dilihat setelah
SMTPLog dinonaktifkan kembali.

Perhatkan bahwa S: berarti reply yang
diberikan oleh server (oleh SMTPLog),
sedangkan C: adalah command yang
diberikan oleh client (oleh Outlook
Express).

FILE SMTP.LOG
Terlihat bahwa pada direktori yang
sama dengan SMTPLog.class
terbentuk file smtp.log yang
merupakan log dari interaksi
antara mail server dengan mail
client.

BUKA SMTP.LOG
Buka file smtp.log dan pelajari
isinya. Tampak disini respons dari
server (S: ) dan dari client (C: ).
Interaksi ini pulalah yang terjadi
bila anda mengirim email anda ke
smtp server yang valid. Log leng-
kap dapat dilihat di kotak di bagian
atas halaman ini.
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3 PROSES LOGGING
Pada jendela dialog DOS tempat
SMTPLog dijalankan terlihat bebe-
rapa pesan. Di sini SMTPLog mem-
bentuk file smtp.log. Biarkan saja
pesan itu dan tutup jendela dialog
DOS ini agar kita dapat membuka
file smtp.log dengan text editor.

MENJALANKAN SMTPLOG
Lewat DOS prompt masuk ke
direktori C:\j2sdk1.4.0\bin dan
ketikkan perintah:
java SMTPLog
dan akan tampak SMTPLog aktif
dan siap merekam interaksi antara
mail server dengan mail client.

NEW MAIL PADA OE 5.0
Pade email client Outlook Express
klik New Mail untuk membuat
suatu email. Selesai menuliskan-
nya klik Send untuk mengirimkan-
nya ke mail server tiruan kita yang
berada di IP address kita dengan
nama alias smtp.neotek.co.id tadi.

1 2

Menjalankan SMTPLog

S: 220 pop3.neotek.co.id Simple Mail Transfer Service
Ready
C: HELO ivan
S: 250 pop3.neotek.co.id
C: MAIL FROM: <kosasih@neotek.co.id>
S: 250 OK
C: RCPT TO: <redaksi@neotek.co.id>
S: 250 OK
C: RCPT TO: <gwidianto@yahoo.com>
S: 250 OK
C: RSET
S: 250 OK
C: RSET
S: 250 OK
C: MAIL FROM: <kosasih@neotek.co.id>
S: 250 OK
C: RCPT TO: <redaksi@neotek.co.id>
S: 250 OK
C: RCPT TO: <gwidianto@yahoo.com>
S: 250 OK
C: DATA
S: 354 Start mail input
C: Message-ID:
<000501c24270$98a648c0$b2207dcb@ivan>
C: From: "Kosasih Iskandarsjah"
<kosasih@neotek.co.id>
C: To: "Redaksi Neotek" <redaksi@neotek.co.id>
C: Cc: "G. Widianto" <gwidianto@yahoo.com>

C: Subject: Test SMTP Server
C: Date: Tue, 13 Aug 2002 10:24:47 +0800
C: MIME-Version: 1.0
C: Content-Type: text/plain;
C: charset="iso-8859-1"
C: Content-Transfer-Encoding: 7bit
C: X-Priority: 3
C: X-MSMail-Priority: Normal
C: X-Mailer: Microsoft Outlook Express 5.00.2615.200
C: X-MimeOLE: Produced By Microsoft MimeOLE
V5.00.2615.200
C: 
C: Halo,
C: 
C: Saya sedang men-tst SMTP Loger.
C: Saya minta komentar dari kalian mengenai proram
ini.
C: Terima kasih.
C: 
C: Salam,
C: Kosasih Iskandarsjah
C: 
C: 
C: .
S: 250 OK
C: QUIT
S: 221 pop3.neotek.co.id Service closing transmission
channel

Kini kita coba POP3 Logger dengan
mengetikkan perintah berikut pada
DOS prompt:
java POP3Log c:\mailbox

untuk c:\mailbox adalah folder yang
berfungsi sebagai mailbox, yaitu tem-
pat mail object disimpan.

Sebagai contoh mail object, ketikkan
teks dalam format ASCII, kemudian
simpan pada folder tersebut.

From: Fitrianto Halim <fitriantoh@hotmail.com>
Subject: Mail Server Tiruan

Hallo...

Saya sedang membuat mail server tiruan.

Fungsinya untuk merekam komunikasi antara mail
client dengan mail server.

Terima-kasih.

Salam,

Fitrianto Halim
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Dapat pula anda memasukkan file-
file berekstensi EML pada folder
tersebut (pada Outlook Express 5.0
dapat dihasilkan dengan memilih
menu File → Save As).

Hasil yang terekam pada file POP3.LOG
tampak pada boks di seelah kanan.

Anda dapat mengembangkan aplikasi
ini, sehingga dapat berfungsi sebagai
mail server sederhana untuk LAN.

Penulis dapat dihubungi di
Fitrianto Halim

(fitriantoh@hotmail.com)

6 ISI POP3.LOG
Nonaktifkan applet POP3Log agar
kita dapat membuka file pop3.log
dengan text editor. Dengan text
editor terlihat interaksi antara server
(S: ) dengan client (C: ) dalam
proses pengambilan mail object
dari suatu mailbox.

RETRIEVE EMAIL
Pada Outlook Express klik
Send/Receive email dan Outlook
Express akan mengambil email
dari mailbox yang telah ditetapkan
yaitu oleh POP3Log yaitu dari
C:\mailbox

EMAIL DAN LOG EMAIL
Email akan terambil dan dapat di-
baca oleh Outlook Express. Selain
itu proses pengambilan email oleh
Outlook Express ini terekam dalam
file pop3.log yang terbentuk pada
direktori yang sama dengan applet
POP3Log.class.
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3 JALANKAN POP3LOG
Jalankan POP3Log dengan menge-
tikkan pada DOS prompt:
java POP3Log C:\mailbox
dan tampak POP3Log aktif dengan
tampilnya pesan:
waiting for incoming connection request...

MENYIAPKAN MAIL OBJECT
Pada Outlook Express klik New
Mail dan tulis suatu email. Kali ini
jangan klik Send, melainkan Save
As... dan simpan sebagai file .EML
pada direktori C:\mailbox

FILE .EML
Katakanlah bahwa anda memberi
nama 00000000.eml pada mail
object yang anda sae ke direktori
C:\mailbox seperti yang terlihat
pada gambar di atas.

1 2

Menjalankan POP3Log

C: USER kosasih
S: +OK
C: PASS jessica
S: +OK
C: STAT
S: +OK 1 644
C: LIST
S: +OK
S: 1 644
S: .
C: RETR 1
S: +OK
S: From: "Kosasih Iskandarsjah"
<kosasih@neotek.co.id>
S: To: "Redaksi NeoTek <redaksi@neotek.co.id>"
S: Cc: "G. Widianto <gwidianto@yahoo.com>"
S: Subject: Test POP3Log
S: Date: Tue, 13 Aug 2002 11:28:35 +0800
S: MIME-Version: 1.0
S: Content-Type: text/plain;
S: charset="iso-8859-1"

S: Content-Transfer-Encoding: 7bit
S: X-Priority: 3
S: X-MSMail-Priority: Normal
S: X-Unsent: 1
S: X-MimeOLE: Produced By Microsoft MimeOLE
V5.00.2615.200
S: 
S: Halo,
S: 
S: Saya sedang mencoba POP3 server tiruan karya
Fitrianto Halim.
S: File ini akan disimpan dalam folder C:\mailbox
sebagai file berekstensi .eml
S: dan akan diakses kembali oleh email client.
S: 
S: Salam,
S: Kosasih Iskandarsjah
S: .
C: DELE 1
S: +OK
C: QUIT

POP3.LOG
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ika anda pemakai Internet, tentunya istilah Web
server bukan sesuatu yang asing. Lewat Web ser-
ver anda—sebagai pengguna Internet—mene-

rima segudang informasi. Tetapi, pernahkah terbayangkan
oleh anda untuk membuat sendiri aplikasi Web Server.

Lewat artikel ini kami mencoba menguraikan cara mem-
buat Web Server sederhana dengan menggunakan Java.

Java dipilih karena, selain mendukung socket program-
ming dan thread, juga lebih mudah dipahami dibanding-
kan jika menggunakan C++.

HTTP
Web Server merupakan salah satu aplikasi protokol TCP
yang menggunakan port 80.

Komunikasi antara Web Server dengan browser didefini-
sikan dalam suatu protokol yang dinamakan HTTP (Hyper-
text Transfer Protocol). Jika tertarik untuk mempelajari-
nya, ada baiknya anda membaca RFC (Request For Com-
ments), terutama RFC-1945 (Hypertext Transfer Protocol
-- HTTP/1.0) dan RFC-2068 (Hypertext Transfer Protocol
-- HTTP/1.1) yang dapat anda download dari ftp.isi.edu.

Hubungan antara Web server dengan browser bersifat
stateless, artinya koneksi dibangun ketika browser me-
ngirimkan request ke Web Server dan koneksi diputus
ketika browser telah menerima response dari Web Server.
Sebagai contoh, ketika kita mengetikkan IP address
“192.0.0.1”, maka browser akan mengirimkan request
berikut ke Web Server (browser yang dipakai oleh penulis
adalah MSIE 6.0):

GET / HTTP/1.1
Accept: image/gif, image/x-xbitmap, image/jpeg,
image/pjpeg, application/vnd.ms-excel, */*

Accept-Language: en-us
Accept-Encoding: gzip, deflate
User-Agent: Mozilla/4.0 (compatible; MSIE 6.0;

Windows 98)
Host: 192.0.0.1
Connection: Keep-Alive

Yang perlu anda perhatikan adalah metode GET, karena
berisi file request yang diinginkan oleh browser.

Program
Web server yang dibuat hanya untuk menanggapi me-
tode GET. File default-nya adalah index.htm (diprioritas-
kan dulu) dan index.html. File default tersebut akan
diberikan jika file request-nya diakhiri dengan “/” atau
merupakan suatu direktori.

Untuk keamanan, anda hanya bisa mengakses direktori
yang telah ditentukan sebagai root.

Source-code dari Web Server ini dapatanda lihat pada file
WebServer.java. Untuk mengkompilasinya ke byte-code,
gunakan perintah:
javac WebServer.java

Pengujian
Dalam percobaan, penulis memasukkan direktori
C:\j2mewtk\docs\api (berisi dokumentasi API untuk Java 2
Micro Edition Wireless Toolkit) sebagai root, dengan
perintah:
java WebServer c:\j2mewtk\docs\api

Jika kita mengaksesnya, maka akan didapatkan hasil se-
perti yang ditunjukkan pada gambar pertama di bawah ini.

Jika kita mengakses
file di luar direktori
yang telah ditentu-
kan, maka akan di-
dapatkan hasil se-
perti pada gambar
kedua di samping
ini. Jika file yang
kita inginkan tidak
ditemukan, maka
akan didapatkan
hasil seperti pada
gambar terakhir.

Web server yang
dibahas di sini ma-
sih sangat
sederhana, karena
hanya melayani
file HTM dan HTML (walaupun dalam percobaan dapat
menampilkan file image), serta hanya menanggapi
metode GET.

Oleh karena itu, silahkan anda mengembangkannya,
misalkan dengan menambahkan header, seperti: content-
type, content-encoding dan lain-lain. Selain itu, pelajari
pula metoea lainnya, seperti: HEAD, POST dan lain-lain.

Atau, jika anda pernah mempelajari teknik pembuatan
interpreter, maka anda dapat memasukkannya sebagai
server side scripting yang unik.

Fitrianto Halim (fitriantoh@hotmail.com)

WWebeb ServServerer SederhanaSederhana
Menggunakan Java untuk MembuatMenggunakan Java untuk Membuat

J

• File diakses pada direktori yang seharusnya.

• File diakses di luar direktorinya.

• File yang diakses tidak ditemukan.
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Standar Selular Digital
anyak orang bicara tentang 2G, 3G bahkan ada pula
yang membicarakan 2,5G. Sebenarnya istilah ini
muncul ketika ada perkembangan generasi sistem

komunikasi digital seluler saat ini. Sesungguhnya 1G (tidak
pernah muncul istilah ini saat teknologi ini lahir) adalah tek-
nologi seluler yang masih bersifat analog dalam konteks trans-
misi antara pengguna ponsel dengan jaringan selulernya. Ke-
lemahannya, gampang dicloning.

Kemudian istilah 2G muncul mengartikan generasi kedua
atau generasi digital. Yakni teknologi seluler yang kita rasa-
kan saat ini. Lalu 3G? 3G pada dasarnya adalah generasi
ketiga di mana sistem digital yang diimplementasikan dapat
mengakomodasi laju bit yang jauh lebih cepat dibanding
2G. Ada lagi yang menyebut 2,5 G yang artinya transisi 2G
menuju 3G. Contoh 2,5G adalah GPRS untuk GSM dan
HSPD dan 1X untuk CDMA.

Standar-standar 2G yang ada sekarang di antaranya; GSM
(Global System for Mobile Communication). GSM ini di-
kembangkan lewat standar Eropa (ETSI = European Stan-
dard Telecommunications Institute). Kemudian standar
Jepang yang biasa disebut PDC. Kemudian ada pula standar
Amerika Serikat, biasa disebut IS-54 (TDMA). Kesemua
standar di atas menngunakan metoda akses yang sama yakni
TDMA (Time Division Multiple Access). Jika kita bicara

teknik pengaksesan, maka sesungguhnya pada 1G (analog)
metode akses yang digunakan adalah FDMA (Frequency
Multiple Access). Pada 2G atau genersai digital saat ini juga
dikenal standar yang menggunakan akses CDMA (Code
Division Multiple Access). Contoh standar yang mengguna-
kan akses CDMA ini misalnya IS-95 dari TIA/EIA, sebuah
lembaga standar telekomunikasi dari Amerika Serikat. Ke-
mudian dikenal pula JCDMA (Jepang) dan KCDMA (Korea).

Seputar Jaringan RF GSM
Pembahasan akan lebih difokuskan pada teknologi dengan
standar GSM karena teknologi ini lebih banyak digunakan
di seluruh dunia dan juga di Indonesia. Teknologi GSM juga
memiliki fitur-fitur yang lebih lengkap dan siap ketimbang
standar teknologi seluler yang lain.

Metoda akses GSM adalah TDMA. Dalam desain sel-sel RF
(Radio Frequency), yang bisa kita representasikan dengan
BTS-BTS (Base Transceiver System), frekuensi yang digu-
nakan adalah dalam range spektrum terbatas. Misalnya un-
tuk band 900 MHz, terdapat 124 alokasi frekuensi yang
mesti dibagi-bagi kepada beberapa operator di suatu negara,
misal di Indonesia, dibagi untuk 3 buah operator (Telkomsel,
Satelindo, dan Excelcom). Alokasi band DCS 1800 (400 alo-
kasi frekuensi) pun dibagi-bagikan kepada tiga oprator tadi
dan pemain baru seperti IM3 dan LippoTel.

Kinerja Jaringan GKinerja Jaringan GSSMM
Anda pernah punya pengalaman buruk dengan ponsel anda? Tapi mengapa terkadang “sinyal”-nya

kuat suaranya masih ping-pong atau jelek? Apa yang terjadi sesungguhnya?

MengintipMengintip

3 HANDPHONE TERHUBUNG
Segera setelah handphone terhu-
bung dengan komputer melalui
port infra merah, terlihat kekuatan
sinyal pada gambar handphone
serta tanda terhubung (hijau) di
bagian kanan bawah.

DOWNLOAD LOGO MANAGER
Download lm128.exe dari situsnya
di http://www.logomanager.co.uk
atau dapatkan dari CD NeoTek
bulan ini. Pada CD NeoTek terse-
dia 2 versi: lm127.exe dan lm128.exe.
Instal lm127.exe dengan jalan
double-click pada file ini dan ikuti
langkah-langkahnya.

KONEKSI KE HANDPHONE
Apabila semua fasilitas ingin diak-
tifkan, copy file crack (dalam for-
mat .exe) ke direktori tempat
LogoManager.exe terbentuk, lalu
double click, maka LogoManager.exe
akan di-patch. Hubungkan kom-
puter dengan handphone. Dalam
contoh ini melalui infra merah.

1 2

Instalasi LogoManager dan Koneksi ke Handphone

B
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Alokasi kanal frekuensi yang digunakan itu mesti diguna-
kan secara benar dan tepat maka desain sel-sel (BTS-BTS)
akan menggunakan frekuensi-frekuensi tersebut berulang-
ulang, disebut frequency reuse. Misalnya di daerah rumah
saya sudah menggunakan frekuensi A maka frekuensi A
tersebut harus digunakan lagi di daerah lain yang letaknya
ditentukan dengan parameter transmit maksimum tertentu
pula agar tidak terjadi interferensi, biasa disebut co-channel
interfernce. Bahkan dalam disain alokasi frekuensi, penen-
tuan frekuensi yang spektrumnya berdekatan pun mesti
sejauh mungkin dihindari. Hal ini dapat menyebabkan in-
terferensi jenis lain yang dalam istilahnya disebut adjacent
channel interference.

Gangguan RF yang Mempengaruhi Kinerja Ponsel
Seorang pengguna pernah menggerutu, “Wah kok di dekat
kantor saya suara HP saya jelek sekali, padahal sinyalnya
full lho...” Ada lagi yang mengeluh seperti ini, “Kenapa ya
belakangan ini, di daerah Palmerah, saya susah sekali mau
bikin panggilan, padahal sinyalnya full?”

Semua ilustrasi di atas di antaranya disebabkan oleh penga-
ruh kesalahan disain sel-sel atau BTS-BTS dalam pengalo-
kasian frekuensi. Banyak pengguna HP yang selalu meng-
acu kepada indikator sinyal di handsetnya untuk meng-
klaim bahwa kualitas jaringan seluler itu bagus atau tidak.

Dalam sistem digital, komunikasi yang terjadi adalah dalam
bentuk stream bit 0 dan 1. Jadi suara kita dimodulasikan
dalam format stream 0 dan 1. Jika jaringan RF terganggu
maka potensial bit-bit yang diterima atau yang dikirim
akan rusak. Sehingga mengakibatkan suara yang tidak
jernih, jelek, drop call, dan tidak bisa membuat call.

Melihat Kualitas Jaringan
Banyak pengguna selular digital yang terseret dengan para-
digma, “Kualitas adalah coverage.” Hal demikian tidak tepat
100%. Di samping coverage, kualitas jaringan juga ditentu-
kan oleh teknik dan trik-trik disain yang harus dilakukan
oleh operator seluler. Sinyal kuat bukanlah penentu bahwa
kinerja jaringan sudah baik. Bagi pengguna ponsel Nokia

atau Siemens, kita dapat mengintip atau setidaknya dapat
memonitor kualitas jaringannya baik atau tidak. Bagaimana
caranya?

Network Monitor NOKIA
Pengguna handset Nokia dapat mengaktifkan mode NNeett--
wwoorrkk  MMoonniittoorr, agar handsetnya dapat mengintip kinerja
jaringannya. Caranya, download LLooggoommaannaaggeerr (ada dalam
CD Neotek). Instal lalu aktifkan mode Network Monitor
ini melalui Logo Manager dengan memilih menu TToooollss >
NNeettwwoorrkk  MMoonniittoorr......

Tentunya handset Nokia Anda harus terhubung dengan
port serial komputer dan untuk itu dibutuhkan kabel
khusus. Bagi handset NOKIA keluaran terakhir dapat
juga mengaktifkan Network Monitor melalui infrared
(IIrrDDAA). Setelah Anda aktifkan (EEnnaabbllee). Maka handset
Anda sudah dapat menu baru yakni menu Network
Monitor.

Untuk ponsel Siemens tipe S25, atau C35, S35, M35 atau
S45 masih dibutuhkan kabel serial dan hanya bisa memoni-
tor jaringan lewat PDA, PC atau laptop. Software yang di-
gunakan bisa Siemens S25 explorer atau Siemens S35
explorer (ada dalam CD NeoTek bulan ini).

Instalasi LogoManager dan Mengaktifkan Network Monitor pada Handphone

6 NETWORK MONITOR
Anda kini dapat memonitor kinerja
jaringan GSM anda baik lewat kom-
puter maupun handphone. Opsi no-
mor 1 (baik pada handphone
maupun LogoManager) menun-
jukkan RxL -79 yang artinya receive
level -79 dBM, TxPwr xxx yang arti-
nya handphone sedang stand by.

NEGARA DAN OPERATOR
Pastikan Country dan Operator
yang dipilih pada LogoManager
sama dengan yang sedang aktif
pada handphone anda. Pilih Tools
> Options... Dalam contoh dipilih
Singapore dan M1 sebab handpho-
ne yang dipakai (Satelindo) sedang
roaming dengan M1 di Singapore.

NETWORK MONITOR
Feature tersembunyi pada handphone
Nokia anda kini dapat ditampilkan.
Pilih Tools > Network Monitor...
dan akan tampil jendela pilihan
Network Monitor. Klik tombol
Enable dan pilih pada opsi Activation
pilih Engineering. Fasilitas ini akan
dibuka pada handphone anda.

4 5

• Data cable
untuk Nokia
8210, 8290,
8810, 8850,

dan 8890 yang
menghubungkan

ponsel dengan
port serial

pada
komputer.
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Dengan Network Monitor (NetMon) NOKIA, Anda sudah
dapat mengetahui hampir seluruh parameter jaringan RF
operator SIM card Anda. Namun parameter yang dimaksud
di sini adalah parameter ddoowwnnlliinnkk atau parameter yang arah-
nya dari jaringan/BTS ke ponsel, untuk uplink tentunya ha-
nya dimonitor di sisi operator. Parameter downlink juga di-
kirimkan ke operator oleh ponsel untuk melakukan kontrol
dan berbagai keputusan. Seperti kontrol kuat sinyal, kepu-
tusan handover dan lain sebagainya.

Kita mulai dengan membicarakan kkuuaatt  ssiinnyyaall. Dalam standar
GSM parameter yang menunjukkan kualitas sinyal adalah
RReecceeiivvee  QQuuaalliittyy  (RRQQ) dan parameter kuat sinyal yang ter-
dapat dalam indikator handset disebut RReecceeiivvee  LLeevveell (RRxxLL).
Kuat Sinyal atau RxL bersatuan dBm (milidecibel). Kuat
sinyal yang normal berkisar antara mmiinnuuss  3300  ddBBmm  hhiinnggggaa
mmiinnuuss  9900  ddBBmm, jadi dengan melihat dengan NetMon bah-
kan kita lebih akurat memonitor kuat sinyal, tidak berdasar-
kan “berapa bar” lagi.

Sedangkan jika kita bicara tentang kkuuaalliittaass  ssiinnyyaall (RRxxQQ) ber-
kisar dalam 8 nilai range yang diindikasikan dengan nilai 00
ssaammppaaii  77. Untuk RxQ yang terbaik adalah 0 dan yang ter-
buruk adalah 7. Nilai RxQ memiliki range pada tabel di atas.

Bisa dibayangkan apabila dalam data bit stream terganggu
di atas 12,8% saja maka suara sudah menjadi tidak jernih
bahkan hubungan pun terputus.

Network Monitor Mode Stand-by
Pada ppoonnsseell anda masuk ke me-
nu NNeettwwoorrkk  MMoonniittoorr, ketik 1
dan pilih OOKK. Pada kondisi stand
by akan terlihat contoh seperti
gambar di samping kiri atas.

Untuk memahami apa arti
angka-angka pada menu 1
NetMon ini, tekan tanda asterix
(*) beberapa saat sehingga dapat
dilihat tampilan seperti tampak
di sebelah kiri bawah.

Posisi CH bernilai 106 artinya
kanal frekuensi yang diguna-
kan adalah 106 (GSM 900). RxL

bernilai -72 artinya kuat sinyal yang diterima ponsel
adalah -72dBm. Jika RxL lebih kecil dari -100 dBm (misal
-108 dBm), indikator tidak menunjukkan tanda minus
lagi namun tetap berarti minus misal: 108.

TxPwr bernilai xxx karena handset stand-by sehingga tidak
memancarkan sinyal ke BTS (tidak ada uplink). TS bernilai
0 artinya untuk semua mode standby, handset selalu me-
lihat dan menerima informasi  jaringan di time slot 0. Time
slot 0 selalu digunakan untuk broadcasting informasi jaring-
an ke ponsel melalui CCCH ata CBCH, lihat penjelasan
tentang CHT.

TA bernilai 1 artinya TA (Timing Advance) bernilai 1 yang
artinya menunjukkan seberapa dekat ponsel dengan BTS
yang melayaninya. Jika Anda ke luar kota maka akan
tampak TA yang bernilai besar misalnya 20. Range TA ini
adalah 0-63.

RxQ bernilai x atau tidak ada karena kualitas sinyal hanya
bisa diukur ketika ponsel dalam kondisi dedicated atau ber-
bicara. RLT juga tidak ada nilainya. RLT (Radio Link Time
Out ) menunjukkan nilai parameter jaringan untuk timer
pengambilan keputusan disconnectiong ponsel dengan ja-
ringan apabila koneksi terganggu. Makin besar RLT makin
besar kemungkinan terputus.

9 EDIT RINGTONE
Punya bakat musik? Edit sendiri ring-
tone yang ada atau buat ringtone
sendiri. Selesai diedit dapat anda
mainkan dengan menekan tombol
dengan logo segitiga (play). Untuk
memainkan di handphone, upload
ke lokasi Phone preview (tidak di-
save) sebelum masuk ke lokasinya.

PHONE EXPLORER
Dengan handphone terhubung ke
komputer, pilih Tools > Phone
Explorer dan anda dapat melihat
apa saja yang terdapat pada
handphone ini. Address book
yang tersimpan baik pada SIM
card maupun handset dapat
dibaca oleh LogoManager.

RESTART, LOGO, DAN TEXT
Pada Tools masih ada pilihan
menu Restart phone, yang artinya
anda dapat mematikan dan
menjalankan kembali handphone
melalui LogoManager ini. Anda
juga dapat mengirim pesan dalam
bentuk teks ke telepon lain.

7 8

Tools Lain pada LogoManager

106 -72 xxx
0  1 x xxxx
31      31

CCCH

CH RxL TxPwr
TS TA RQ RLT

C1     C2
CHT

• Adanya BER
(bit error rate)
di atas 12,8%

sudah menunjukkan
kualitas sinyak

yang amat buruk.

RxQ BER (Bit Error Rate)

0 BER < 0,2%
1 0,2% < BER < 0,4%
2 0,4% < BER < 0,8%
3 0,8% < BER < 1,6%
4 1,6% < BER < 3,2%
5 3,2% < BER < 6,4%
6 6,4% < BER < 12,8%
7 BER > 12,8%
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Nilai C1 dan C2 sebagai contoh adalah 31 menunjukkan
kriteria jaringan untuk melakukan handover atau pindah
band dari 900 MHz ke 1800 MHz atau sebaliknya.

CHT mengindikasikan CCCH artinya handset sedang men-
duduki kanal logic CCCH (Common Control Channel) atau
artinya handset dalam kondisi standby mendengarkan kanal
umum dari BTS yang melayaninya.

Network Monitor Mode Dedicated
Apabila anda menghubungi
suatu nomor telepon dengan
ponsel anda, maka ponsel da-
lam mode dedicated.

Pada mode dedicated, muncul
nilai TxPwr, RxQ dan RLT.
Nilai CHT berubah dari CCCH
menjadi sesaat AGCH dan
SDCC dan akhirnya TFR.

TxPwr = 7 artinya ponsel memancarkan kuat sinyal 7
dBm. Jika ponsel letaknya jauh dari BTS terdekat, maka
kuat sinyal pun menjadi lebih besar. Makanya jika Anda
berpergian ke luar kota, baterai ponsel terasa cepat habis,
karena ponsel harus meradiasikan sinyalnya ke BTS
(uplink) dengan power yang besar.

RxQ bernilai 0 yang berarti kualitas sinyal sangat baik.
CHT berubah menjadi TFR artinya ponsel menduduki
time slot (TS) no 7 dengan kanal logik TFR. TFR artinya
ponsel menggunakan traffic Full Rate. Beberapa operator
seperti IM3 dan Telkomsel sudah menggunakan transkoder
EFR di infrastrukturnya yang berfungsi meningkatkan
kebeningan suara. Maka jika Anda melihat CHT bernilai
TEFR artinya EFR di ponsel Anda aktif. Beberapa ponsel
harus mengaktifkan mode EFR secara manual dengan
mengetik *3370# kemudian ponsel akan reset.

Untuk indikator kanal frekuensi (CH) kadang kala ada
huruf H di depan nilainya pada mode dedicated. Ini berarti
bahwa jaringan (BTS) dan ponsel sedang melakukan hop-
ping frekuensi. Teknik hopping frekuensi ini juga salah
satu teknik untuk meningkatkan kualitas jaringan, sehing-

ga pengguna ponsel bisa berpindah-pindah kanal frekuensi
apabila kanal frekuensi yang didudukinya tidak bagus.

Teknik hopping frekuensi ini juga dilakukan operator untuk
meningkatkan daya guna alokasi frekuensi yang terbatas
tadi. Teknik hopping frekuensi ini kerap diterapkan di dae-
rah urban atau daerah padat pemakai, seperti di tengah kota.

Menu Network Monitor yang lain
Masih banyak lagi misteri menu Network Monitor NOKIA
yang tentunya perlu penjelasan yang panjang. Seperti mi-
salnya menu 2 untuk melihat informasi tentang cell.

Menu 3, 4, dan 5 untuk melihat cell "tetangga" (neighbour)
di samping cell yang sedang melayani ponsel kita. Menu
11 memperlihatkan lokasi cell dan no cell yang sedang me-
layani ponsel kita. Menu 11 ini sangat berguna dalam apli-
kasi positioning. Konon kabarnya salah satu operator di sini
dimintai polisi untuk mendeteksi buronan yang diketahui
menggunakan no ponsel dan akhirnya tertangkap karena
didapati informasi bahwa buronan tersebut sering meng-
gunakan ponsel di lokasi yang terlihat pada menu 11 itu.

Disi Setiadi [didi@prasimax.com]

Penulis adalah seorang konsultan pada Excel Consulting
dan seorang developer di PRASIMAX Technology
Deveolpment Center.

Manajemen Logo: Namanya Juga LogoManager

12 EDIT DAN UPLOAD IMAGE
Image ini dapat anda edit dengan
copy, paste, clip, maupun input teks
dan pola grafis lainnya seperti tam-
pak pada graphics palette di sisi
kanan. Selesai edit, file dengan eks-
tensi *.nlm ini dapat anda upload
kembali ke handphone anda.

VIEW LOGO
Pada menu View, selain dapat
melihat antrean SMS yang ada
pada handphone, juga dapat
melihat grafik untuk handphone
ini, yang mencakup Operator
Logo, Group Graphics, Startup
Logo, dan Picture Message.

DOWNLOAD IMAGE
Anda bisa mengambil grafik yang
tersimpan pada handphone dengan
File > Get current image from phone.
Yang diambil pada contoh adalah
Startup Logo pada handphone
Nokia.

10 11

H106 -72 * 7
7  3 0   20
31      31

TFR
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ROGRAMMER DALAM PEMAKAIAN MCU adalah hal
mutlak. Untuk mempelajari programmer akan di-
bahas cara merealisasi proyek Digital Clock. Berikut

ditampilkan rancangan programmer untuk MCU KX8 yang
dipakai dalam proyek tersebut.

Tahapan dalam metode pengembangan software yang akan
dipakai di sini adalah sebagai berikut:

1. Software DDiiggiittaall  CClloocckk..aassmm diketik di text editor. File
tersebut disebut file assembly.

2. Software tersebut di-asembling. Proses ini menghasilkan
beberapa file penting:
• DDiiggiittaall  CClloocckk..llsstt (listing). Untuk mencari kesalahan

dalam pembuatan software.
• DDiiggiittaall  CClloocckk..SS1199 (object code). Untuk diprogram ke

dalam MCU.
• DDiiggiittaall  CClloocckk..MMAAPP (map file). Untuk menampilkan

source code di debugger.
3. OObbjjeecctt  CCooddee  SS1199 diprogram ke dalam MCU menggu-

nakan pprrooggrraammmmeerr (hardware) dan diatur oleh soft-
ware programmer.

Metode di atas hanya menggunakan programmer. Ini ada-
lah cara yang paling sederhana dan paling mudah dilakukan

Software yang digunakan ics08kxz_ver_x_xx_ xxxxxx.exe
yang dapat di-download dari wwwwww..ppeemmiiccrroo..ccoomm atau dari
CD NeoTek bulan ini. Software ini termasuk klasifikasi
WWIINN  IIDDEE (WINdows Integrated Development Environment)
yang artinya lengkap untuk semua proses yang diperlukan.

Download software ICS08KXZ dan instal. Software tersebut
“free for personal use” dan “full feature” yang artinya tidak
ada yang dikurangi walaupun kita tidak bayar. Yang diharap-
kan membayar adalah instansi atau usaha yang menghasil-
kan uang. Subsidi silang diharapkan berjalan di sini.

Perhatikan skema hardware programmer di bawah. Bagian
kiri atas adalah unit power supply yang menghasilkan te-
gangan 12 V (yang di sini belum dipakai) dan 5 V. Trafo
menurunkan tegangan AC 220V menjadi 15 V AC lalu di-
searahkan oleh dioda bridge (jembatan), diratakan C1.

U1 adalah IC Regulator (penstabil) tegangan 12V dibantu
C2 untuk lebih meratakan tegangannya dan C3 untuk
mencegah osilasi. U2 menghasilkan tegangan 5V stabil
yang dibutuhkan programmer dibantu C4 dan C5. Indi-
kator LED (Light Emitting Diode) menandakan power
supply sedang aktif. R1 membatasi arus LED agar tidak
rusak.

PrProoyyekek DigitalDigital ClockClock ((11))
Microcontroller adalah mikroprosesor lengkap dengan RPM, RAM, dan I/O dalam suatu chip
sehingga bisa disejajarkan dengan mikrokomputer sendiri. Selanjutkan kita akan gunakan istilah MCU

untuk microcontroller. Membuat program untuk MCU memerlukan piranti yang disebut programmer.

ProgrProgrammer MC68HC908-KX8ammer MC68HC908-KX8

P

• Skema Programmer KX8
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Sedangkan Xtal 10 MHz di bagian kanan atas dipakai un-
tuk External Clock MCU yang setelah dibagi 1024 menja-
di 9766 bps. Sebenarnya untuk mendapatkan baudrate
standard 9600 bps digunakan 9.834 MHz. Tapi karena Xtal
ini agak sulit didapat dan juga karena baudrate software
WIN IDE bisa diset menjadi berapa saja termasuk 9766
bps (sejauh PC nya memungkinkan), maka hal ini tidak
menjadi masalah. Bahkan dengan Xtal 10 MHz yang me-
leset 1.7 persen pun, komunikasi tetap bisa dilakukan de-
ngan baik.

Bagian bawah adalah programmer yang sebenarnya. Di-
mulai dari konektor DB9F (female) yang dihubungkan ke
PC. Sinyal yang lewat konektor ini adalah sinyal dengan
standard RS232 yang artinya tegangannya positif untuk
logika 0 dan tegangan negatif (minus) untuk logika 1.
Sinyal ini perlu disesuaikan dengan tegangan rangkaian
lain yang hanya mengenal tegangan 0 volt dan plus dan
tidak boleh mendapat tegangan minus. Selain itu tegang-
an sinyal RS232 lebih tinggi dari 5 V. Untuk itulah fungsi
MAX232 yang bekerja mengubah tegangan sinyal RS232
menjadi tegangan logika biasa dan sebaliknya. Fungsi C7
dan C9 untuk membentuk tegangan positif 10V yang juga
dipakai untuk MCU. C8 dan C10 membentuk tegangan
minus 10V.

Seperti yang terlihat, sinyal dari PC menggunakan 2 jalur
untuk komunikasi serial 2 arah, sedangkan di MCU ha-
nya ada 1 jalur (pin 3 - PTA0). MCU menggunakan 1 pin
untuk komunikasi serial 2 arahnya. 74HC125 berfungsi
sebagai splitter sinyal dari MCU agar bisa berkomunikasi
dengan PC. Perbedaan metode ini dari cara biasa adalah
adanya sinyal dari PC yang selalu kembali ke PC. Tapi de-
ngan software yang sudah Anda install hal itu sudah di-
tangani dengan sangat baik bahkan dijadikan alat diag-
nostik communication loop. Diagnostik ini melingkupi
MAX232 dan 74HC125.

Agar bisa masuk ke mode Monitor yang bisa dipakai un-
tuk fungsi Programming, In-Circuit Simulation, In-Circuit
Debugging, MCU harus mendapat kondisi khusus sewaktu
pemberian tegangannya yang menghasilkan kondisi
POWER ON RESET. ICS dan ICD dibahas di artikel men-
datang.

Kondisi itu adalah tegangan 0V di PTA1dan PTB1 dan
tegangan VDD (di sini adalah 5V) pada PTA0 dan PTB0
dan Clock di PTB6 yang akan dibagi 1024 untuk menjadi
baudrate serialnya serta tegangan IRQ yang lebih tinggi
dari VDD (cukup dengan VDD untuk kondisi tertentu).

Selanjutnya tersedia switch Push-On untuk me-RESET
MCU secara hardware. Reset secara software dilakukan
dengan software ICS08KXZ setelah komunikasi berhasil.

Persiapan Programming
Setelah Software di Install dan Programmer (hardware) sele-
sai dirakit, jangan pasang MCU KX8 dulu di soket program-
mer lalu pastikan kapasitor terpasang dengan polaritas yang
benar serta MAX232 dan 74HC125 terpasang dengan benar,
baru hidupkan programmer. Indikator LED Hijau D5 menyala
menandakan power supply bekerja dengan baik. Sangat dian-
jurkan untuk memeriksa tegangan keluaran U1 sebesar 12V
dan U2 yang 5V untuk memastikan semuanya baik. Tegangan
10V di pin 4 MCU yang berasal dari MAX232 berguna untuk
memastikan MCU bisa masuk mode monitor. Flash ROM
programming yang akan dikerjakan nanti merupakan salah
satu fungsi dari mode monitor. Sebenarnya MCU motorola
ini mampu melakukan Flash ROM programming dalam
mode user (mode kerja biasa) tapi tidak dibahas di sini.

Matikan Programmer lalu hubungkan Konektor DB9F ke
COM1 atau COM2 di PC dengan kabel Straight yang
artinya pin 1 nya ke pin 1 sampai pin 9 ke pin 9 juga pada
type kabel DB9M dan DB9F. Sebenarnya hubungan yang
diperlukan cuma pin 2, 3, 5. Apabila konektor COM di PC
yang tersedia hanya yang 25 pin maka perlu dibuat kabel
dengan hubungan pin 2 DB9M ke pin 3 DB25F, pin 3
DB9M ke pin 2 DB25F dan pin 5 DB9M ke pin 7 DB25F.
Pasang MCU di soketnya dengan posisi yang benar.

Programming
Jalankan Software ICS WIN IDE yang bertindak sebagai text
editor untuk file ASM dan manager untuk file exe lainnya
seperti Simulator, In-Circuit Simulator, In-Circuit Debu-
gger, Programmer.

Ketik software DigitalClock.asm lalu save dengan nama ter-
sebut. Pengetikan manual ini berguna untuk melatih ke-
telitian yang sangat dibutuhkan dalam pembuatan soft-
ware. Gunakan tab untuk pindah field.

Field dalam software dalam bahasa assembly terdiri dari:

• Label: Nama lokasi yang berguna sebagai tujuan branch
(pencabangan) atau Jump (lompatan).

• OpCode: Instruksi untuk MCU (mnemonic) yang dibuat
ringkas tapi masih mudah diingat fungsinya.

• Operand: Kelanjutan dari OpCode berupa object yang
dikerjakan berdasarkan OpCode tersebut.

• Comment: Komentar untuk baris di sampingnya. Berguna
untuk mengingat cara kerja software dilain waktu.

Agar hasil ketikan terlihat rapi, set tabulasi menjadi fix 15
character.

Selain itu juga dianjurkan memasang remark (catatan)
untuk subroutine atau sesuatu yang dirasakan penting
untuk diingat.

Hal penting lainnya yang perlu diperhatikan adalah sin-
taks bahasa assembly. Hampir setiap bahasa assembly
(bahkan untuk MCU yang sama) menggunakan sintaks
yang sediki berbedat. Software yang dibuat untuk di-
assembling oleh software Assembler ABC biasanya perlu
diubah syntaxnya agar bisa di-assembling oleh software
DEF. Karena itulah sering kali di header software Assem-
bly dituliskan nama Assembler yang dipakai.

• Setting Environment agar file Digital Clock.asm mudah
dibaca.
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Setelah selesai pengetikan, save file tersebut. Lakukan
assembling dengan menekan tombol pertama yang ter-
letak di bawah menu File. Proses Assembling terjadi dengan
cepat. Apabila pengetikan tidak menyalahi sintaks dan
tidak ada kesalahan simbol (nama sebagai pengganti angka-
angka), maka proses akan lancar dan akan timbul pesan
bahwa proses assembling sukses. Kesalahan akan ditun-
jukkan oleh software sebagai garis merah dan kita diminta
untuk memperbaikinya. Perbaiki lalu lakukan proses
assembling lagi.

Yang patut diperhatikan adalah jangan sampai terjadi ke-
salahan seperti nama simbol tertukar, salah mode addres-
sing (misalnya ada tanda # yang terlewatkan) karena ke-
salahan seperti ini mengganggu jalannya software tetapi
lolos dari proses assembling.

Sejauh ini (pengetikan dan assembling) pekerjaan kita cu-
ma melibatkan software. Jadi untuk yang belum punya
hardware  programmer dapat melakukan proses tersebut.

Hasilnya adalah file listing, object code dengan standar
motorola (S19), dan MAP file. Bandingkan file S19 hasil
assembling dengan yang di artikel Project Digital Clock.
Kesalahan ketik akan menghasilkan perbedaan antara ke-
dua file ini.

Hidupkan Programmer
Tekan tombol ke 3 (programmer - EXE2) dengan icon
kilat menyambar IC (di WIN IDE) untuk memulai proses
programming. Akan Tampil kotak dialog berikut:

Pastikan setting berikut sudah benar:

• Set Target Hardware Type ke Class III (tiga).
• PC Serial Port and Target BaudrateConfiguration diset

ke Port yang dipakai untuk berhubungan dengan Pro-
grammer. Pilih Baudrate 9600 (sebenarnya meleset 1,7
persen tapi masih bisa dipakai) atau pilih Spesified dan
isi angka 9766 di box sebelahnya. Untuk mengubah itu
kadang perlu menutup port dulu dengan menekan
tombol “Close Com Port.”

• Target MCU Security bytes di posisi “IGNORE security
failure and enter monitor mode.”

Tekan tombol “Contact target with this settings ...”

Apabila tidak ada kesalahan setting atau hardware Program-
mer, maka akan tampil kotak dialog yang meminta kita
memilih algoritma programming, pilih KX8. Kotak dialog
box tersebut akan hilang digantikan dengan aktifnya

fasilitas yang tersedia saat ini. Fasilitas yang tidak aktif
ditandai dengan kalimat NOT ACTIVE.

Karena saat ini kita masuk dengan kondisi Ignore Secur-
ity (dengan assumsi Flash ROM sudah berisi firmware -
software yang menjadi hardware), maka isi Flash tidak
bisa dibaca. Kondisi hanya berguna untuk menghapus isi
Flash.

Klik ganda baris “EM Erase Module.” Dalam sekejap isi
flash sudah terhapus dengan indikasi tulisan “Done” pada
Window Status. Lagi-lagi karena waktu masuk Monitor
Mode tadi dengan kondisi Ignore Security, maka kita
tidak bisa lakukan verifikasi untuk memastikan apakah
benar benar sudah kosong (blank). selanjutnya kita akan
diberi info bahwa akan dilakukan proses reset agar
programmer bisa melakukan verifikasi MCU benar benar
sudah kosong (blank Check). Setelah proses reset dengan
security bytes (FF-FF-FF-FF-FF-FF-FF-FF Blank Device),
anda baru bisa melakukan blank check. Pastikan status
Un-Secured = YES.

Pada waktu dilakukan reset, software meminta kita
melakukan POWER CYCLE dengan mematikan power
untuk waktu sekitar 5 detik (untuk memastikan tegangan
maksimum di MCU dari sisa kapasitor tidak lebih dari 0.1
Volt) dan menyalakan kembali. Tekan Tombol OK.

Lakukan Blank Check untuk memastikan sudah Blank.
Untuk melakukan programming, tentukan dulu S record
nya. Double click “SS Specify S record.” Pilih S19 yang
akan diprogram ke Flash ROM MCU. Klik ganda “PM
Program Module” untuk program. Selesai sudah proses
programming. Tutup aplikasi.

• Kotak dialog “Contact Target dan Security Pass.”

• Programmer dengan konfigurasi Un-Secured = NO.

• Programmer dengan konfigurasi Un-Secured = YES.

Penulis (Hardy The) dapat dihubungi melalui email:
hardythe@cbn.net.id

baik mengenai artikel proyek Digital Clock
maupun bantuan membuat

hardware programmer yang diperlukan.
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ETIAP ORANG YANG MENGAKSES INTERNET pasti
menginginkan agar semua layanan yang ada di
Internet dapat diakses dengan cepat dan mudah.

Apapun aktivitas yang sedang dilakukan, bila koneksi ke
Internet terlalu lambat, apalagi sampai putus, rasanya ti-
dak ada hal yang lebih menjengkelkan selain dari pada
itu. Nah, agar keinginan itu tercapai, tidak sedikit orang
yang rela mengeluarkan sejumlah uang untuk meng-
upgrade atau mengganti komputernya dengan komputer-
komputer yang terbaru saat ini. Bahkan tidak hanya
komputer, modem yang tadinya internal, dengan kecepat-
an 56 Kbps pun juga ikut diganti menjadi jenis eksternal
yang lebih ber-”merk,” termasuk mengganti account ISP
dengan account ISP lain yang dirasa jauh lebih baik. De-
ngan perasaan optimis semua itu dilakukan agar nantinya
akses ke Internet bisa lebih cepat dibanding sebelumnya.
Bagi orang yang mampu, urusan ganti mengganti seperti
disebutkan di atas jelas bukan hal yang sulit, tapi apakah
itu solusi yang terbaik? Tentu saja tidak! Karena masih
ada cara lain yang jauh lebih murah, tanpa harus meng-
upgrade, meng-expand, atau membeli yang baru.

Kita tahu bahwa secara teknis ada beberapa faktor yang
menyebabkan akses ke Internet menjadi sangat lambat,
yaitu antara lain adalah sebagai berikut:

1. Kualitas atau kondisi saluran telepon tidak begitu baik.
2. Terjadi distorsi atau interferensi pada saat modem

melakukan proses konversi data dari mode digital ke
analog, atau sebaliknya dari analog ke digital.

3. Cuaca sangat buruk.
4. Infrastruktur ISP kurang memadai.
5. Bandwidth yang dimiliki ISP tidak terlalu besar.
6. Banyak pengguna Internet yang masuk secara

bersamaan, yang akhirnya menyebabkan lalu lintas
jaringan menjadi sibuk (padat).

7. Kinerja modem tidak optimal karena tidak disetting
dengan benar.

Dari penjelasan tersebut di atas (butir 1-6), kita bisa me-
ngatakan bahwa ke enam faktor teknis tersebut sifatnya
adalah optional, artinya bisa saja mungkin benar-benar
terjadi atau tidak sama sekali. Dan kalaupun itu memang
benar terjadi, maka tidak ada yang dapat anda lakukan
selain menunggu sampai kepadatan lalu lintas jaringan
berkurang, kualitas saluran telepon menjadi baik, cuaca
berubah menjadi cerah, atau tidak ada lagi distorsi ketika
modem melakukan proses konversi data, dan lain sebagai-
nya. Namun pada butir ke 7, tentu saja anda tidak mung-
kin menunggunya berubah dengan sendirinya jika bukan
anda sendiri yang melakukannya. Nah, agar kinerja mo-
dem anda benar-benar optimal, anda tidak perlu meng-
instal program seperti Speedy Net, Speed Surfer, atau
NetSonic, tetapi cukup dengan mengatur setting properti
modem dan setting registry sistem operasi Microsoft
Windows anda secara proporsional.

Langkah-langkah untuk mengatur kedua setting tersebut
adalah sebagai berikut :

Mengatur Setting Registry
1. Jalankan program RReeggiissttrryy  EEddiittoorr (Start → Run →

Regedit), lalu berpindahlah ke folder HKLM\System\
CurrentControlSet\Services\VxD\MSTCP.

2. Buat string baru bernama DDeeffaauullttRRCCVVWWiinnddoowwss..
Caranya, klik menu Edit → New → String Value, lalu
ketikkan string tersebut.

3. Klik kanan pada DefaultRCVWindows yang barusan
anda buat, lalu pilih Modify. Pada kolom Value data,
masukkan angka 2244, lalu klik OK.

4. Setelah itu pindahlah ke folder HKLM\System\
CurrentControlSet\Services\Class\NetTrans.

5. Buat key baru bernama TCP/IP. Caranya, klik menu
Edit → New → Key, lalu ketikkan TCP/IP.

6. Buat string baru bernama MMaaxxMMTTUU. Caranya, klik menu
Edit → New → String Value, lalu ketikkan MaxMTU.

Connection TConnection Twweakingeaking
Optimasi Kinerja ModemOptimasi Kinerja Modem

Sebagai sarana untuk mengakses Internet, modem memegang peran penting atas kelancaran aktivitas kita
ketika ber-Internet. Eryanto Sitorus (ery@postmaster.co.uk) menjelaskan kiat menggenjot kerja modem

lewat pengaturan pada registri maupun properti modem.

S
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7. Klik kanan pada string MaxMTU, lalu pilih Modify. Pada
kolom Value data masukkan angka 2000, lalu klik OK.

8. Keluarlah dari program Regedit, lalu boot ulang
komputer anda. Kemudian lakukan proses dial-up ke
ISP, jalankan browser, lalu akseslah salah satu situs,
perhatikan baik-baik apakah sekarang akses Internet
sudah lebih cepat?

Mengatur Setting Properti Modem

1. Masuklah ke dalam menu Dial-Up Networking,
kemudian klik kanan salah satu icon dialup yang sudah
anda buat sebelumnya, lalu pilih Properties.

2. Pada jendela ikon dialup, klik tombol Configure.
Kemudian pada tab General pilihlah speed (kecepatan)
maksimal, yaitu 115200.

3. Setelah itu klik tab Connection, lalu klik tombol Port
Settings. Pastikan bahwa pilihan Use FIFO buffers (re-
quires 16550 compatible UART) dalam keadaan aktif.
Lalu geser (maksimalkan) petunjuk Receive Buffer dan
Transmit Buffer ke arah samping kanan, klik OK.

4. Kembalilah ke tab Connection, lalu klik tombol Advanced.
Kemudian pada jendela Advanced Connection Settings,
nonaktifkan pilihan [√] Use error control, lalu klik OK.

• Gambar 1: Membuat string baru bernama DefaultRCVWindows.

• Gambar 6: Memaksimalkan FIFO buffers.

• Gambar 4: Jendela ikon dial-up. • Gambar 5: Memaksimalkan
kecepatan (speed) modem

• Gambar 3: Memilih menu Properties Icon Dialup.

• Gambar 2: Membuat string baru bernama MaxMTU.

• Gambar 7: Menonaktifkan pilihan User Error Control.
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5. Tutuplah semua program yang sedang terbuka, lalu
boot ulang komputer anda. Kemudian lakukan proses
dial-up ke ISP, perhatikan baik-baik apakah sekarang
akses Internet sudah lebih cepat dibanding sebelumnya?

Selain kedua hal tersebut di atas, sebenarnya masih ada
satu hal lagi yang juga tidak kalah penting untuk anda
perhatikan, yaitu pastikanlah bahwa ruang (space) yang
tersisa pada hard disk komputer anda cukup besar. Sema-
kin besar space yang tersisa, maka akan semakin cepat
pula komputer anda melakukan tugasnya.

Jika anda merasa space harddisk komputer anda sudah mulai
berkurang, periksalah program-program aplikasi yang
anda rasa sudah tidak diperlukan lagi, dan jika memungkinkan,
hapuslah file-file program tersebut melalui proses
uninstal. Caranya, klik menu Start → Settings → Contol
Panel → Add/Remove Programs. Kemudian pada jendela
Add/Remove Programs Properties, pilihlah program yang
akan anda hapus, lalu klik tombol Add/Remove. Setelah
itu, masih dari jendela Add/Remove Programs, klik tab
Windows Setup. Periksalah apakah masih ada program-

program yang memungkinkan untuk anda uninstal,
misalnya seperti Address Book, Desktop Themes, Games,
dan lain-lain. Hapuslah semua program tersebut bila anda
tidak membutuhkannya dengan cara menonaktifkan [√]
pilihan program.

Anda juga jangan sampai lupa, bahwa semakin banyak
situs yang anda kunjungi maka akan semakin banyak
pula file yang didownload oleh browser anda. Oleh karena
itu biasakan untuk selalu mengosongkan folder

• C:\Windows\Temporary Internet Files,
• C:\Windows\Downloaded Program Files,
• C:\Windows\Temp

dan folder-folder yang lainnya seperti Recyle Bin, Tempo-
rary PC Health Files, Application debugging information.
Untuk mengosongkan semua folder tersebut sekaligus,
caranya adalah sebagai berikut:

1. Jalankan Windows Explorer.
2. Klik kanan ikon hard disk drive C, lalu pilih Properties.
3. Pada jendela (C:) Properties tab General, klik tombol

Disk Cleanup.
4. Aktifkanlah semua pilihan [√] file/folder yang akan

dihapus, lalu klik OK.
5. Jawab pertanyaan “Disk Cleanup will permanently

delete the selected files from your system. Are you
sure you want to delete files?” dengan menekan
tombol Yes.

• Gambar 8: Memeriksa space
hard disk yang tersisa.

• Gambar 9: Menghapus software
yang sudah tidak diperlukan.

• Gambar 10: Menghapus
program yang tidak diperlukan.

• Gambar 11: Masuk ke dalam
jendela (C:) Properties.

• Gambar 12: Menghapus file-file temporary. • Gambar 13: Memeriksa folder Temporary Internet Files.
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NTUK MENDAPATKAN AKSES KE SUATU JARINGAN, pe-
nyerang harus mendapatkan user name yang valid,
seperti telah dibahas dalam Enumerasi: Mematang-

kan Serangan (NeoTek Juli 2002). Dalam bahasan enumerasi
juga ditunjukkan bahwa sangat mungkin sewaktu enumerasi,
penyerang sudah dapat mengakses sistem yang dituju, khu-
susnya sistem yang mendukung NetBIOS seperti sistem
Windows maupun Samba pada Linux.

Telah dibahas bagaimana penyerang tanpa banyak usaha da-
pat masuk ke komputer seseorang melalui remote share yang
tidak diproteksi password, menggunakan NNeettBBIIOOSS  ssccaannnniinngg
ttooooll seperti Legion, SMBScanner, atau Shares Finder. Bila share
tersebut dilindungi dengan password, maka serangan brute

force dapat dilakukan langsung secara remote untuk menebak
password share bersangkutan. Di sini yang dibahas adalah
null-session connection yang artinya penyerang dapat meng-
akses remote share tanpa harus menggunakan user account.

Selanjutnya pada NeoTek September 2002 dibahas lebih lan-
jut tentang password cracking. Di sini sebenarnya dibahas
mekanisme password cracking dengan akses lokal. Yang di-
maksud dengan akses lokal adalah bahwa penyerang dapat
mengakses sistem secara fisik (seperti meng-crack BIOS pass-
word, screen saver password, cached password, atau menda-
patkan file-file yang berisi password yang terenkripsi seperti
file .PWL (pada Windows 9x/ME) atau file .SAM (pada Win-
dows NT/2000). Juga dibahas CCaaiinn  22..00 yang bertindak seba-

RRemote Pemote Passwassworord Crd Crackingacking
Mendapatkan Akses di Sistem SasarMendapatkan Akses di Sistem Sasaranan
Remote password cracking adalah usaha mendapatkan entri ke suatu sistem secara online/remote,

yang biasanya mencari user account yang valid beserta password-nya. Sekali diperoleh,
penyerang akan mendapatkan local login di sistem sasaran untuk kemudian meningkatkan privilege-nya. 

UU

3 POP MAIL PASSWORD
Misalkan user kosasih lupa password-
nya di pop.indo.net.id, maka dapat
diusahakan ditebak password-ya
dengan masuk ke pop.indo.net.id
dengan Target Type POP3. Bila pass-
word telah ditemukan terlihat
Positive authentication yang diakhiri
dengan disengaged dari server.

FTP PASSWORD
Pada contoh ini Brutus dicoba untuk
menebak password user gianto pada
FTP server (port 21) milik redaksi
NeoTek (wFTPd) pada IP address
203.125.28.177. Dipilih user name
gianto dan metode yang dipilih
adalah Dictionary Attack menggu-
nakan passfile.txt

DI SISI SISTEM SASARAN
Di sisi FTP server yang diserang ter-
lihat adanya usaha login dari user
‘gianto’ yang terus menerus tanpa
hasil. Pada contoh ini tidak diterap-
kan account lockout sehingga usaha
login akan terus-menerus dilakukan
sampai berhasil. Paling tidak usaha
intrusi ini dapat dicatat pada log.

1 2

Brutus—Remote Password Cracking
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gai remote password stealer, yang dapat dikategorikan sebagai
password stealing trojan. Akses lokal ditandai dengan diper-
olehnya command shell atau login ke dalam sistem. Semua
itu dikategorikan sebagai akses lokal (walaupun Cain dioperasi-
kan secara remote).

Remote access berbeda dengan local access, sebab di sini ak-
ses didapat melalui network atau channel komunikasi lain.
NeoTek pernah membahas salah satu bentuk remote access
untuk mendapatkan password, yaitu password sniffing dengan
merekam lalu-lintas paket data yang melewati suatu network
card (April 2002). Tool untuk merekam lalu-lintas paket
data, di antaranya ttccppdduummpp (Linux) dan wwiinndduummpp (Windows)
serta aplikasi terapannya untuk mengendus password, ddssnniiffff.

Perlu dipahami hubungan antara remote access dengan local
access. Sekali penyerang mendapatkan user account yang valid
dan password-nya melalui remote access, maka ia sudah men-
dapatkan login (atau bahkan command shell) ke sistem. Ta-
hap berikutnya, yaitu meningkatkan privilege akses (dari
user biasa ke admin) sudah merupakan akses lokal. Itu sebab-
nya local access attack disebut juga privilege escalation attack.

Remote access attack untuk mendapatkan password suatu sis-
tem disebut juga sebagai remote password cracking. Apabila
hal ini merupakan kelanjutan dari enumerasi, maka biasanya
user account yang valid sudah didapat dan kini tinggal men-
dapatkan password untuk account itu. Berbeda dengan local
access password cracking, tidak banyak metode yang dapat di-
gunakan untuk remote password cracking. Pada remote pass-
word cracking yang lazim digunakan adalah menebak pass-
word baik dengan dictionary attack ataupun brute force attack.

Brute Force Attack terhadap Listening Service
Serangan terhadap suatu sistem dapat dilakukan dengan meng-
eksploitasi listening service yang ada pada sistem tersebut, misal-
nya telnet, ftp, rlogin, atau ssh. Tanpa adanya servis yang ber-
jalan, walaupun mempunyai user account absah (serta password-
nya sekalipun), anda tidak dapat mengakses suatu sistem.

Brute force attack tidak tampak ‘wah,’ tetapi tetap merupakan
cara efektif untuk mendapatkan akses ke suatu sistem, baik
itu Windows, Linux, ataupun lainnya. Setelah mendapatkan
akses sebagai user biasa, barulah untuk meningkatkan privi-

lege menjadi admin digunakan local access yang memanfa-
atkan kelemahan-kelemahan yang ada pada sistem.

Brute force attack pada dasarnya hanyalah usaha menebak
user ID dan/atau password. Pelbagai servis yang lazim
menjadi sasaran brute force adalah:

a. telnet
b. File Transfer Protocol (FTP)
c. 'R' command pada Linux (rlogin, rsh, dan lainnya)
d. Secure shell (SSH)
e. SNMP community names
f. Post Office Protocol (POP)
g. Hypertext Transfer Protocol (HTTP/HTTPS)

Menebak password dapat saja dilakukan secara manual, teta-
pi umumnya penyerang menggunakan utilitas brute force
attack otomatis seperti misalnya Brutus dan Entry.

Brutus
www.hoobie.net

Brutus adalah suatu online atau remote password cracker, atau
tepatnya suatu remote interactive authentication agent. Brutus
digunakan untuk mendapatkan akses yang absah berupa user
name dan password untuk suatu sistem sasaran tertentu. Sis-

6 SERANGAN MELALUI PROXY
Brutus menyediakan fasilitas peng-
gunaan proxy untuk melakukan
serangan remote password cracking-
nya. Dengan cara ini paling tidak IP
address penyerang tidak terlihat
pada sistem sasaran.

SEMUA DAPAT DI-CRACK, TAPI...
Di sini dicoba men-crack password
user kosasih pada sdf.lonestar.org
dengan telnet. Ternyata pada usaha
ke-62 sudah dihentikan oleh ser-
ver (account lockout) padahal me-
nurut perhitungan Brutus untuk
brute-force 6 sampai 8 karakter ini
perlu waktu 3 abad lagi...

WEB PASSWORD
Untuk mendapatkan password dari
suatu halaman Web, anda harus
memilih apakah password itu me-
rupakan basic authentication (HTTP
Basic Auth) atau merupakan pass-
word yang merupakan entri pada
suatu formulir pada CGI (HTTP
Form).

4 5



tem sasaran yang dimaksud dapat berupa server FTP, halaman
web yang diproteksi dengan password, ataupun konsol ter-
hadap suatu POP server.

Keberhasilan remote password attack bergantung beberapa hal:
a. Adanya servis yang terbuka untuk remote system.
b. Sederhana atau tidaknya persyaratan untuk akses (hanya

password saja, user name dan password, atau juga
memerlukan domain name?).

c. Ada tidaknya account lockout. Adanya account lockout
akan membatasi usaha menebak password.

d. Ada tidaknya persistent connection pada servis bersangkutan.

Terlihat pada Gambar 1, Brutus menyediakan fasilitas brute
force attack terhadap berbagai jenis service, yaitu:

a. HTTP (basic authentication), port 80
b. HTTP (form atau CGI), port 80
c. FTP (File Transfer Protocol), port 21
d. POP3 (Post Office Protocol), port 110
e. Telnet, port 23
f. SMB/NetBIOS, port 139
g. Custom (mendefiniskan sendiri tipe serangan), port 23
h. NetBus (authentikasi Trojan NetBus), port 12345

Perlu diingat bahwa banyak sistem yang akan mencatat
kegagalan berturut-turut dalam otentikasi yang di antaranya
terjadi sewaktu melakukan serangan brute force dan identitas
penyerang (IP address atau domain name-nya) dapat dicatat
oleh sistem itu. Itu sebabnya remote password cracker menye-
diakan pula faslitas pemanfaatan proxy server..

Entry 2.7
www.sparkleware.com

Entry 2.7 seperti
juga Brutus me-
rupakan remote
brute-force secu-
rity auditing
utility. Dengan
hanya meng-klik
mouse anda dapat
melakukan usaha
mendapatkan
password dari
situs-situs web,

FTP, serta POP mail. Entry LE dengan fasilitas terbatas dapat
di-download dari situsya atau dapat diperoleh dalam CD
NeoTek bulan ini.

Walaupun servis yang dapat diserang oleh Entry 2.7 tidak
sebanyak Brutus, namun Entry 2.7 mempunyai beberapa
kelebihan, di antaranya:

a. Dapat menggunakan HTTP proxy server.
b. Dapat mengkoordinasi serangan simultan pada banyak

komputer.
c. Secara otomatis membuat HTML log dari semua situs

yang sudah di-crack
d. Mendapatkan multiple password dalam sekali serangan
e. Dapat melakukan lebih dari 200 usaha login per menitnya.
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Bagaimana Hacker Mendapatkan Password Anda?
assword cracking hanyalah
salah satu cara yang diguna-
kan hacker untuk menda-

patkan password anda. Ada banyak
lagi cara lain, termasuk social engin-
eering, yaitu kata lain dari menipu.

Pada dasarnya ada empat cara untuk
mendapatkan password secara ‘lebih
terhormat,’ yaitu:

• Menghadang email yang mengirim-
kan password pada anda.

• Menggunakan password cracker
untuk mendapatkan password anda.

• Menggunakan web spoofing untuk
melihat apa yang anda ketikkan se-
cara online, termasuk password anda.

• Menggunakan Java applet dan
ActiveX untuk mengakses hard
disk dan mencari password yang
tersimpan di dalamnya.

Menghadang Email
Pada dasarnya tidak sulit untuk
menghadang email. Salah satunya
adalah menggunakan mmaaiillssnnaarrff yang
terdapat pada utility ddssnniiffff. Mailsnarf
menghadang paket data yang lewat
di Internet dan menyusunnya men-
jadi suatu email utuh di layar.

Dsniff dibahas di NeoTek April 2002
mengenai password sniffing. Dapat-
kan dsniff di CD NeoTek bulan ini.

Password Cracking
Ada dua macam password cracker. Cara
lama adalah dengan mencoba kombinasi
password satu per satu sampai didapat
password yang cocok. Cara ini dikenal
sebagai dictionary attack (bila menco-
bakan kata-kata yang ada dalam kamus)
atau brute-force attack (mencobakan se-
mua kombinasi huruf, angka, dan karak-
ter). Cara ini sangat lambat dan banyak
situs sekarang yang menutup akses ter-
hadap usaha login yang terlalu banyak
secara berturut-turut tidak berhasil.

Cara lain adalah mencari password anda
dari dalam dan cara ini hacker harus
masuk ke dalam sistem anda. Ini bisa
karena kelemahan sistem atau meru-
pakan kenakalan ‘orang dalam’ sendiri.

NeoTek edisi ini membahas yang per-
tama (remote password cracking), se-
dangkan yang kedua (local access pass-
word cracking) telah dibahas di NeoTek
September 2002.

Web Spoofing
Web spoofing pada dasarnya adalah
usaha menipu anda agar anda mengira
bahwa anda sedang mengakses suatu
situs tertentu, padahal bukan.

Cara yang pernah dilakukan terha-
dap situs Web BCA adalah dengan
membuat situs mirip BCA yang mem-
buat orang terkecoh sehingga tanpa

curiga mengetikkan nama dan pass-
word-nya dan nama dan password
itupun direkam di server sang penipu.

Cara lain adalah dengan menjadi situs
Web perantara anda dengan situs yang
anda akses. Dengan kata lain menjadi
proxy server untuk anda dalam berse-
lancar. Ada contoh proxy server yang
tidak berbahaya, yaitu Anonymizer
(hhttttpp::////wwwwww..aannoonnyymmiizzeerr..ccoomm/), yang
membuat identitas anda tidak diketahui
oleh situs yang anda kunjungi. Tetapi
seluruh identitas anda (dan juga apa
yang anda lakukan justru diketahui
oleh proxy server ini).

Java applet dan ActiveX
Suatu applet Java atau ActiveX dapat
diciptakan untuk mengakses hard disk
anda dan melakukan apa saja terha-
dapnya, termasuk membaca password
yang tersimpan dalam program pe-
nyimpan password.

Fasilitas Windows yang menawarkan
untuk mengingat password anda sangat
berbahaya, sebab membuat password
itu tersimpan di cache memory dan
dapat diakses dengan mudah dengan
pelbagai password revealer (dibahas
di NeoTek September 2002).

Lebih aman menyimpan password anda
di secarik kertas. Tidak juga di zip file
sebab sudah dibahas juga bahwa zip file
dapat di-crack juga.
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